Intuit® Academy

Most Common QuickBooks Mistakes and How to Fix Them
Copyright
Copyright 2011 Intuit, Inc. All rights reserved.

Trademarks
©2011 Intuit Inc. All rights reserved. Intuit, the Intuit logo, Intuit ProLine, Lacerte, ProAdvisor, ProSeries and QuickBooks, among others, are trademarks or registered trademarks of Intuit Inc. in the United States and other countries. Other parties’ marks are the property of their respective owners.

Notice to Readers
The publications distributed by Intuit, Inc. are intended to assist accounting professionals in their practices by providing current and accurate information. However, no assurance is given that the information is comprehensive in its coverage or that it is suitable in dealing with a client’s particular situation. Accordingly, the information provided should not be relied upon as a substitute for independent research. Intuit, Inc. does not render any accounting, legal, or other professional advice nor does it have any responsibility for updating or revising any information presented herein. Intuit, Inc. cannot warrant that the material contained herein will continue to be accurate nor that it is completely free of errors when published. Readers should verify statements before relying on them.
TABLE OF CONTENTS

About the Author............................................................................................................................4

Introduction.....................................................................................................................................6
  Objectives ..................................................................................................................................6
  Notes about Approach ...............................................................................................................6
  Accessing Your Client’s Data File as External Accountant User ..............................................9
  Client Data Review (CDR) .......................................................................................................12

List Errors......................................................................................................................................14
  Errors & Symptoms ..................................................................................................................14
  Review List Changes ...............................................................................................................15
  Correcting Account Types.......................................................................................................16
  Merging or Inactivating Duplicate Chart of Accounts or List Items ..........................................17
  Overview of Items ....................................................................................................................20
  Changing the Account(s) Assigned to an Item.........................................................................22
  Misclassified Transactions .......................................................................................................22

Growing Balance in Undeposited Funds ......................................................................................25
  Errors & Symptoms ..................................................................................................................25
  Purpose of the Undeposited Funds Account ............................................................................26
  Undeposited Funds Account Review .......................................................................................27
  Undeposited Funds Account Fixes ..........................................................................................29
  Clear up Undeposited Funds Account with CDR .................................................................30
  Fixing Numerous Errors in Undeposited Funds without CDR ..................................................33

Accounts Receivable – Small Open Balances or Open Credits ..............................................39
  Errors & Symptoms ..................................................................................................................39
  Fix Unapplied Customer Payments and Credits with CDR .....................................................40
  Manually Cleaning up Open Items without CDR .................................................................41
  Write-off Small Balances .......................................................................................................43
  Customers and Vendors are the Same ....................................................................................48

Accounts Payable Errors.............................................................................................................49
  Errors & Symptoms ..................................................................................................................49
  Fix Unapplied Vendor Payments and Credits .........................................................................50
  Check Written Instead of Pay Bills .........................................................................................51
  Accrual Basis – No Bank Reconciliation ...............................................................................51
Accrual Basis – Bank Reconciliation Completed ................................................................. 52
Cash Basis – Bills Not Needed ............................................................................................. 55
Printing 1099-Misc Forms ................................................................................................. 56

Credit Card Errors ............................................................................................................. 59
Errors & Symptoms ............................................................................................................ 59
Credit Card Type Account ................................................................................................. 60
Credit Card Transaction Entry - One Entry or Many? ...................................................... 60
Credit Card Reconciliation ............................................................................................... 61
Extra Payments .................................................................................................................. 61

Sales Tax Errors .............................................................................................................. 62
Errors & Symptoms .......................................................................................................... 62
Reports to Review Proper Sales Tax Liability Balances .................................................... 63
Correcting Sales Tax Payment Errors .............................................................................. 67
Find and/or Fix Incorrectly Paid Sales Tax ................................................................... 67
Adjust Sales Tax Payable ................................................................................................ 70

Payroll Errors .................................................................................................................. 71
Errors & Symptoms .......................................................................................................... 71
Warnings Reduce Errors .................................................................................................. 72
Find Incorrectly Paid Payroll Liabilities ........................................................................ 73
Getting the Red Out—Clearing out Past Due Liabilities .................................................. 74
Additional Areas to Troubleshoot Payroll Errors ............................................................ 76
Locating Non-Payroll Transactions .................................................................................. 77
Creating Payroll Liability Checks Directly in the Checkbook Register ......................... 78

Inventory Errors .............................................................................................................. 79
Errors & Symptoms .......................................................................................................... 79
Inventory Fixes .................................................................................................................. 83

Prior Period Balance Discrepancies ............................................................................... 90
Errors & Symptoms .......................................................................................................... 90
Troubleshoot Account Balances ...................................................................................... 91
Additional Reporting to Help Troubleshoot Beginning Balance Changes in QuickBooks .. 93
Set Closing Date and Password ....................................................................................... 100

Opening Balance Equity Account .................................................................................... 102
Errors & Symptoms .......................................................................................................... 102
Why Transactions Post to the Open Balance Equity Account ........................................ 102
Most Common QuickBooks Mistakes and How to Fix Them

Reviewing Balances in Open Balance Equity Account .......................................................... 103

Miscellaneous Helpful Information ........................................................................................... 106
  Void a Check Written in a Prior Period .................................................................................. 106
  Working with Classes ............................................................................................................. 108
  Working with Jobs .................................................................................................................. 109
  Working with PayPal Accounts .............................................................................................. 110
  Journal Entries Overview ....................................................................................................... 113
  Recording Expenses Paid for by the Owner .......................................................................... 114
  Using Multiple Currencies ...................................................................................................... 115
  Using Unit of Measure .......................................................................................................... 117
  Create a Practice/Testing File ............................................................................................... 120
ABOUT THE AUTHORS

Diana A. Crawford, CPA
Managing Partner: Crawford, Merritt & Company
Atlanta, Georgia

www.cmccpas.com

Diana A. Crawford, CPA is an Advanced Certified QuickBooks ProAdvisor and a national trainer for Intuit and has presented CPE courses on ProSeries, QuickBooks and various other topics for the National Society of Accountants, the Georgia Society of CPAs, the North Carolina Society of CPAs, the U.S. Department of Labor and the U.S. Department of Health and Human Services. She is one of the elite few members of the Intuit Trainer/Writer Network. She is a Certified QuickBooks Enterprise ProAdvisor and Certified POS ProAdvisor.

Diana is managing partner of Crawford, Merritt and Company, Certified Public Accounts which provides QuickBooks consulting and training, tax services and financial coaching to business owners. She is also a networking specialist, and coaches others on ways to identify their true target clients and how to network to reach them. She is the Organizer of a QuickBooks MeetUp group and teaches QuickBooks courses at the local community school.

Before starting her own practice, Diana worked with an Atlanta CPA firm. She earned a Bachelor of Administration in Accountancy from Georgia State University. She has been a CPA for over twenty years. She is a member of the American Institute of Certified Public Accountants and the Georgia Society of Certified Public Accountants.

Michelle L. Long, CPA, MBA is owner of Long for Success, LLC specializing in QuickBooks consulting and training and coaching small business owners. She is an Advanced Certified QuickBooks ProAdvisor and has a unique relationship with Intuit as one of the few national trainers, a consultant for product development and author for Intuit Academy. In addition to teaching thousands of people about QuickBooks, Michelle is the author of Successful QuickBooks Consulting and How to Start a Home Based Bookkeeping Business. Michelle was recently named one of ‘10 Women who Inspire a Profession’ by Accounting Today and was named a Financial Services Champion of the Year for 2007 by the SBA. She has been
INTRODUCTION

Many businesses are using QuickBooks but few businesses use the program correctly. QuickBooks is very easy to use with the proper setup and training on the correct methods to enter transactions; however, many clients have learned to use the software by trial and error. Because recorded check looks just like the check the client wrote and an invoice is easily generated and sent, clients mistakenly think they are generating accurate accounting records. Unfortunately, these clients lack the accounting knowledge and analytical skills to review the financial statements to ensure accuracy.

The issues and resolutions addressed in this training will better equip you to quickly and easily identify the common QuickBooks errors clients make and understand the methods to effectively and efficiently correct them.

Assisting a client with generating an accurate financial statement can identify may the client has in recording transactions. Clients will appreciate your service when they realize you are a QuickBooks expert and can train them on how to use the software correctly. Ultimately this provides them with more timely and accurate financial information from which they can make better business decisions.

NOTE: Keep in mind that this course includes the most common mistakes clients make, but it is by no means all encompassing of all the mistakes you will encounter when working with clients.

OBJECTIVES

- Identify data file types and other initial considerations
- Explore symptoms and causes of common mistakes
- Determine if these mistakes occurred and the impact on the accounting records
- Assess alternatives available to fix these mistakes
- Identify ways to minimize these mistakes in the future.

NOTES ABOUT APPROACH

Because various users choose to use the navigators on the home page, or not, and may customize the icon bar, these instructions will use the menu bar at the top of the software. QuickBooks® PREMIER: Accountant Edition 2011 is the version of the software that is used in this course. While many of the fixes will work with other versions, this is the most comprehensive and feature rich product and includes the reports and functionality accountants want and need. We are using the sample data file (Rock Castle Construction) included with the software to make it easy for you to test the solutions with your own copy of the software back in your office.
Most Common QuickBooks Mistakes and How to Fix Them

The majority of these fixes require that you have access to the live data file. Some solutions cannot be implemented when using the Accountant’s Review Copy of the data. There are many ways to access the live data including working at the client’s office, obtaining a back up or portable copy of the data file to use in your office (don’t forget to remind the client not to enter any transactions while you have it or your back up or portable file will overwrite their information), utilizing the Accountant’s Copy or using QuickBooks Accountant 2011 feature of Remote Access or another service that allows remote access to the client’s computer.

**IMPORTANT** Note: One of the most important processed you can stress to your clients is the routine and frequent backup of the QuickBooks data file. Do not overwrite the previous QuickBooks backups. Back up before you start and at every major step along the way. In most cases, you will not need to restore the backup, but if you do, being able to restore the data to a specific point in time is critical. Be sure that if the backup is made to the client’s hard drive, you can locate the file and save the backup to another medium such as a CD or USB drive.

**NOTE:** You can be the hero by reminding your clients that they need frequent and regular backups of their data. The backups should be done from within QuickBooks and not just via their overall computer or network backup. The backups should be to at least two different locations such as the hard drive and a CD or USB drive. Physically separating the backups is also a good recommendation to make. An offsite backup is also strongly recommended.
QuickBooks does not have an undo, undelete, or any other way to say “Oops, I didn’t mean to do that.” For this reason, in addition to the back ups, printing key financial reports as permanent records is also encouraged. Reports can be printed electronically to PDF files. Just be sure to view the report and ensure the proper page settings have been used for a useful report. The page setting such as “Fit report to one page wide” can make reports easier to read.

**NOTE:** You do not have to print to paper, you can print to PDF and save it electronically. You can get CutePDF free ([www.cutepdf.com](http://www.cutepdf.com)) and select it as you would any printer.

When significant errors are detected and correcting the errors will take a considerable amount of time, your client needs to understand and appreciate the level of expertise you possess that allows you to correct these errors. Walking the client through the errors and teaching them the proper method of handling the transactions should help them properly process the transactions next time.
ACCESSING YOUR CLIENT’S DATA FILE AS EXTERNAL ACCOUNTANT USER

The Accountant’s Copy is an easy way to document the changes you make to your client’s QuickBooks file. If you use the Accountant’s Copy feature in QuickBooks Premier: Accountant 2011, your changes will be tracked and documented for you and your client. Your client will have the opportunity to accept or reject them when you give them the accountant’s copy back and then to merge the changes into their existing data file. You can also print these changes.

NOTE: Make sure to communicate to the client that they should NOT cancel the Accountant’s copy or restore the data file. If another Accountant’s Copy is generated, your changes will not import as the file is serialized to only accept changes in from the last Accountant’s copy file generated.

The External Accountant role was added in 2009 and gives you another way to track the changes you make to your clients’ data files. The Administrator of your client's file creates an External Accountant role for you in their data file. You will make your changes as the External Accountant in the client’s live QuickBooks data file. The External Accountant user allows the Accountant access to all areas of QuickBooks similar to the Administrator role. In the past, in order to get Administrator level access, the Accountant would have to sign in as the Administrator on the file. The downfall of signing in as the Administrator is that any changes that the Accountant makes become indistinguishable from those changes the client makes. With the External Accountant user, the Accountant has access to all sensitive accounting activities and information in the QuickBooks data file without needing to be logged in as the Administrator and can easily identify whether a change was made by the Administrator or themself.

NOTE: The only limitations for the External Accountant user role are that you are unable to add, edit or delete existing users of the QuickBooks file and you cannot view customer credit card information.

The Administrator of the QuickBooks data file is the only person that can create an External Accountant User in the QuickBooks file. Once created, the Accountant should always log on as the External Accountant User to perform accounting tasks in the QuickBooks file. This enables any changes made by the accountant in the QuickBooks file to be tracked separately. The External Accountant should be the only one allowed to have this user role in QuickBooks since it has Administrator-level access to the QuickBooks file. Instruct your client to not use the External Accountant login or give the login information to anyone else in the office.

NOTE: You are able to log in as the External Accountant in QuickBooks Pro and Premier Editions and QuickBooks Enterprise Solutions, as long as the Administrator creates this user role for you in their company file.
To setup an External Accountant User (by the Administrator):

1. On the **Company** Menu, select **Users**.
2. Select **Set Up Users and Roles**.
3. Click **New**...
4. Enter **User Name** and **Password** for the Accountant.

5. Select the **External Accountant** access for the Accountant, click **Add**, and then click **OK**.
CLIENT DATA REVIEW (CDR)

Client Data Review (CDR) is included in QuickBooks Accountant and QuickBooks Enterprise Accountant Edition. Limited Client Data Review functionality can be accessed in QuickBooks Pro and Premier when you log in as the External Accountant User. Client Data Review helps to easily identify and clean up data entry errors made by your clients in QuickBooks.

Client Data Review helps accounting professionals be more productive when detecting and correcting client data errors. When asked in a ProAdvisor newsletter survey (April 2008), accounting professionals indicated that as much as 60% of their billable time is spent troubleshooting and correcting client data files, yet it remains one of the least profitable activities the professionals provide for their clients.

The Client Data Review feature includes the following:

- A single working screen that provides access to tools and reports only available in CDR
- Links to critical QuickBooks menus and reports
- Real–time data refresh as corrections are made to the client’s data
- “Freezes” your prior period reviewed balances. The next time you review the client’s file your stored balances are compared to current QuickBooks balances for that review period. If CDR finds a difference, a recommended journal entry to restore your original balances is prepared for your review (You choose whether or not to post the entry.)
- A tool to quickly reclassify transactions
- Tracks changes to the QuickBooks lists including additions, deletions, merges or edits
- Provides a working screen to conveniently apply open customer or vendor payments or credits to associated open invoices or vendor bills
- A tool to write off unpaid invoices
- A tool to troubleshoot inventory balances
- Tracks the status of individual review ‘steps’ as well as documenting overall review notes
- Marks a review as ‘completed’ allowing you to either re-open the review or begin a new period review
- A printable detailed report of the changes made during the review
- Available for use in QuickBooks Accountant’s Copy data sharing file type (limited to features available in Accountant’s Copy)

Throughout this course, the Client Data Review tools are discussed where applicable.
Most Common QuickBooks Mistakes and How to Fix Them

### Client Data Review

<table>
<thead>
<tr>
<th>Task</th>
<th>Status</th>
<th>Task Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Data Review <em>not available outside CDR</em></td>
<td>In Progress</td>
<td></td>
</tr>
</tbody>
</table>

#### Account Balances

<table>
<thead>
<tr>
<th>Task</th>
<th>Status</th>
<th>Task Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Troubleshoot Prior Account Balance</td>
<td>In Progress</td>
<td></td>
</tr>
<tr>
<td>Radiant Transactions</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Open Working Trial Balance</td>
<td>In Progress</td>
<td></td>
</tr>
</tbody>
</table>

#### Review List: Changes

<table>
<thead>
<tr>
<th>Task</th>
<th>Status</th>
<th>Task Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart of Accounts</td>
<td>In Progress</td>
<td></td>
</tr>
<tr>
<td>Taxes</td>
<td>In Progress</td>
<td></td>
</tr>
<tr>
<td>Fixed Asset Bases</td>
<td>In Progress</td>
<td></td>
</tr>
<tr>
<td>Company Name</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Review Payee Setup</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Customers</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Vendors</td>
<td>Not Started</td>
<td></td>
</tr>
</tbody>
</table>

#### Accounts Receivable

<table>
<thead>
<tr>
<th>Task</th>
<th>Status</th>
<th>Task Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fix Unpaid Customer Payments and Credits</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Clear Up Undeposited Funds Account</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Review AR Aging Summary Report</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Write Off Invoices</td>
<td>Not Started</td>
<td></td>
</tr>
</tbody>
</table>

#### Accounts Payable

<table>
<thead>
<tr>
<th>Task</th>
<th>Status</th>
<th>Task Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fix Unpaid Vendor Payments and Credits</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Enable and Correct 1099 Account Mapping</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Review Unpaid 1099 Report</td>
<td>Not Started</td>
<td></td>
</tr>
</tbody>
</table>

#### Sales Tax

<table>
<thead>
<tr>
<th>Task</th>
<th>Status</th>
<th>Task Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fix Manifestly Recreated Sales Tax</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Adjust Sales Tax Payables</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Manage Sales Tax</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Pay Sales Tax</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Sales Tax Preferences</td>
<td>Not Started</td>
<td></td>
</tr>
</tbody>
</table>

#### Inventory

<table>
<thead>
<tr>
<th>Task</th>
<th>Status</th>
<th>Task Notes</th>
</tr>
</thead>
</table>

#### Payroll

<table>
<thead>
<tr>
<th>Task</th>
<th>Status</th>
<th>Task Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find Previously Paid Payroll Liabilities</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Review Payroll Liabilities</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Review Employee Default Settings</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Enter After Payroll Payroll</td>
<td>Not Started</td>
<td></td>
</tr>
</tbody>
</table>

#### Bank Reconciliation

<table>
<thead>
<tr>
<th>Task</th>
<th>Status</th>
<th>Task Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Accounts</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Locate Discrepancies in Bank Reconciliation</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Review Missing Checks</td>
<td>Not Started</td>
<td></td>
</tr>
</tbody>
</table>

#### Miscellaneous

<table>
<thead>
<tr>
<th>Task</th>
<th>Status</th>
<th>Task Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Closing Date and Password</td>
<td>Not Started</td>
<td></td>
</tr>
<tr>
<td>Review Queueable Preferences</td>
<td>Not Started</td>
<td></td>
</tr>
</tbody>
</table>

**Review Notes**

- Request from client bank statement dated 12/31/19.
- Send paperwork from purchase of Dell computer 9/2014.
LIST ERRORS

ERRORS & SYMPTOMS

Common Errors

- Duplicate customers, vendors, items or accounts
- Accounts used instead of customers, vendors, or items
- Accounts, customers, vendors or items showing, but no longer used
- Numerous miscellaneous, one time vendors, customers or items
- Items setup and used incorrectly

Symptoms

- Customer, Vendor, Item, Chart of Accounts and Other Names list is long
- Balance Sheet contains Customer or Vendor Names
- Profit & Loss contains too many accounts, vendor names appear

One of the best places to start cleaning up a client's file is with the Chart of Accounts. If the Chart of Accounts is too long, if there are duplicate accounts, or if the accounts have been set up as the incorrect type, a quick clean up of the Chart of Accounts can solve many issues. Classification problems of accounts are resolved through correcting the account types for the accounts in the Chart of Accounts.

Looking over the Chart of Accounts list or creating the Balance Sheet and Profit & Loss reports will provide an indication of the extent of the issue.
**Review List Changes**

Within the Client Data Review feature is a tool to help you review and analyze list changes made by the client. Here you can review the different lists in QuickBooks for changes that your client made since your initial set-up of the file or your last round of clean-up. Accounts and/or list items Added, Changed, Deleted or Merged since the last review will be identified. The following lists can be viewed for these changes through Client Data Review:

- Chart of Accounts
- Item List
- Payroll Item List
- Fixed Asset Item List

Changes that your clients have made to these lists will be identified easily and you can make corrections in the QuickBooks file based on your analysis. Your changes are tracked as well. You can QuickZoom into any list item or account shown in to the Edit window, from there, any necessary changes can be made.

The Client Data Review does not track changes to the Customer and Vendor List. However, by selecting these lists through Client Data Review, you are directed to the Customer or Vendor Center, depending on which list you choose. The links serve as reminders to go to each of these lists to review for duplicate names that should be merged, inactivated or deleted during your clean-up engagement. (Reminder that once names are merged, this process cannot be undone, so ensure reliable backups are available and proceed with caution.)
CORRECTING ACCOUNT TYPES
Say that a Customer has set up their “Loan from Bank of America” account as an Income type account. The Account needs to be edited and the appropriate account type selected. Using the CDR makes corrections to the lists or Chart of Accounts easier, simply double-click on the item itself and have the edit box opens.

In the example, double click on the account Loan from Bank of America. The edit box is opened. From the Account Type drop down menu, change the account type to the correct one, in the example below the correct change is from Income to Long Term Liability.
MERGING OR INACTIVATING DUPLICATE CHART OF ACCOUNTS OR LIST ITEMS

Often clients will inadvertently create duplicate accounts or list items. This is especially common when there are multiple users of a QuickBooks data file. You can clean up the lists by making names inactive or merging them as explained below.

Duplications can be made inactive by following these steps:

1. Click Lists, Chart of Accounts.
2. Right click the account to be edited and select Edit Account.
3. Place a checkmark in the Account is inactive box, see the following screen capture.

Inactive accounts will not appear in list selections but will appear in financials for periods with activity. For this reason, “deactivating” paid-off loans and fully-amortized asset accounts is the preferred method rather than merging or deleting. Additionally, if you are inactivating a Balance Sheet account that should not show a balance, then clear the activity in the account before inactivating it.

Duplicate accounts can also be merged. As shown in the Client Data Review tool, the accounts (and other list items) and the destination account for the merger are shown.

Proceed with caution as once you merge an account, this process cannot be undone. All prior transactions appear as if they had always been posted to the original account.
**NOTE:** When merging, be very careful as to which account you select to merge. The account that you want dissolved and merged into another account is the account that should be edited. For example, if an account has been created that is called BofA Checking and the account number from the bank has been entered in the description, then a new account simply called Checking has been created without the account number. If the objective is to end up with one account, with the account number in it, then open the new account entitled Checking and change it to BofA Checking, being certain that the name is exact to the account you want to merge it in to. All the account information for the account being merged will be lost and the information in the account will remain. This process remains true for all other lists as well. For example, you should merge in a customer without an address into a customer with an address so the address information is not lost.

To merge two accounts, do the following:

1. Click **List > Chart of Accounts**, highlight the account you no longer want, right click and choose Edit Account.

2. If you are using account numbering, replace the account number with the account number for the account you want to retain. If you are not using account numbering, type the exact spelling of the name (including spaces) of the destination account you are merging this one into.

3. QuickBooks cautions you that the name is already being used and asks whether you would like to merge them.

4. Click **Yes**.

```
[Image: Edit Account window showing Account Type: Expense, Number: 60600, Account Name: Bank Service Charges]
```

5. Type the account number (or name of General Ledger account) you wish to keep. This will move the transactions from the old account, and “merge” them into the account you want to keep.

```
[Image: Edit Account window showing Account Type: Expense, Number: 60600, Account Name: Bank Fees]
```
Bank Service Charges will now be merged in Bank Fees account.

Duplicate Items, Vendors, Customers, Other Names Lists can be merged using the same process. (Employee list items cannot be merged).

**NOTE:** If two accounts are to be merged and they have different account types, the account types must first be changed to be the same account type before the merge can take place. This step must be completed first and the account saved. The account to be used also cannot be a subaccount of another account. These changes must be done one step at a time.

**NOTE:** When Balance Sheet accounts are merged, any cleared transactions are merged into the new account as uncleared.
OVERVIEW OF ITEMS

Items handle the behind-the-scenes accounting in QuickBooks. When an item is created, the account to be used for all transactions involving the item is selected. When the item is used in a transaction, an entry is posted to the account indicated and another entry to the appropriate offsetting account such as accounts receivable, accounts payable, checking, fixed asset, or other type of account is made to balance the entry. The Item list and the associated inventory, income and cost of goods sold or expense account for each item should be reviewed to ensure the transactions are posting as you intend them to.

The most common error in the Item List comes from an item being linked on both purchase transactions and sales transactions to the same account. When a new item is created, the box This item is used in assemblies.... should be checked. Once the box is checked, two account boxes appear, one for the purchase account and one for the sales account. When the box is not checked, an expense account is not assigned, only an income account. A one-sided item causes transactions to post incorrectly to the general ledger.

If this item is used on either a Check or Bill and also on a customer Invoice, both the cost from the Check or Bill and the revenue from the Invoice will be recorded to the “Labor Income” account as selected here. To correct this, make the item a two-sided item by checking the box and separating the income and expense account.
This setup will correctly record expenses to a cost of goods sold account on a purchase transaction and revenue to a revenue account on a sales transaction.
CHANGING THE ACCOUNT(S) ASSIGNED TO AN ITEM
All item types, except sales tax items, can be edited to change the accounts assigned to the item. When an item is changed, an option is given to change either all future transactions or to update all existing and future transactions. *If you choose Yes, the prior financials will be restated.* Before *making these changes, make a backup of the client data and print the Trial Balance.* Compare the results after the change is made to ensure the intended results were achieved.

![Account Change](image)

MISCLASSIFIED TRANSACTIONS
Clients often classify transactions inconsistently or improperly. Changing each transaction can be cumbersome and time consuming. The Reclassify Transactions tool in the Client Data Review allows multiple transactions to be reclassified at the same time.

![Client Data Review](image)

In the past, to analyze a client’s financial statements, the Profit & Loss and Balance Sheet would be analyzed and then the account mappings from the Items List would be reviewed. As the reports are reviewed, transactions are identified which were entered incorrectly and posted to the wrong account. Each transaction would then have to be corrected or a journal entry would be made to correct the account balances. These journal entries mask the detail of the transactions. The Reclassify Transaction tool streamlines this process tremendously; however transactions with items cannot be reclassified using this tool. If Items are identified which are mapped to the incorrect account, the corrections must be made via the Items list.
Consider these scenarios:

When examining the Profit & Loss Detail, the Office Supplies Expense account includes several amounts paid to a vendor called Gina’s Catering. Upon further analysis, you determine that these transactions should have been posted to Meals & Entertainment Expense account. The Reclassify Transaction tool makes reclassifying these transactions simple.

If a client uses classes, and numerous transactions have no class assigned, these transactions are easily corrected with the Reclassify Transaction Tool as well. Implementing use of classes can also be easily done using the Reclassification Transaction Tool.

The **Reclassify Transaction** tool in Client Data Review will save a considerable amount of time identifying and correcting multiple transactions with one click!

1. Select a **Name**—either a vendor, customer or job. The default date range is the review period, but the date range can be changed if desired.

2. The default is to **show transactions that can be reclassified**. Optionally, All Transactions or Transactions you cannot reclassify—item based can be selected for viewing.

**NOTE**: Item-based transactions can be displayed, by changing the selection in the Show transactions dropdown list, even though this tool cannot be used to reclassify them. The Items List can be used to identify and fix incorrectly set up items.

3. To include journal entries in the list, check the **Include Journal Entries** box.

**NOTE**: QuickZoom on any transaction by double clicking it to see the entire transaction.

![Reclassify Transactions Tool](image)
4. Select one or more transactions to move to an account. For example, there are several transactions posted to Office Supplies which are to be reclassified to Meals & Entertainment.

5. Select the new account and optionally a class in the list at the bottom of the window.

6. Click on the Reclassify button.

7. If there are more transactions for this name to reclassify, repeat steps 2-4 as many times as needed.

This tool can be used to assign all these transactions to the Overhead class by first using Select All, then selecting the Overhead Class and Reclassify to quickly and efficiently assign all transactions to the proper class.

**NOTE:** Instead of selecting individual transactions, simply chose Select All, the proper Account and Class and Reclassify to fix all transactions quickly and efficiently.

After a few clicks, all of the transactions will be moved to the proper account and class.

**NOTE:** The Reclassify Transaction tool allows reclassification of transactions to income or expense accounts (including cost of goods sold, other income or other expense). Transactions cannot be reclassified to a balance sheet account. A transaction posted to a balance sheet account can be posted to an income or expense account.
GROWING BALANCE IN UNDEPOSITED FUNDS

ERRORS & SYMPTOMS

Common Errors
- Make Deposit is used to record payments without selecting payments from Undeposited Funds and typically an income account is used to record the deposit, overstating income.
- Deposits were entered directly into the checkbook register—typically posting it to an income account.

Symptoms
- Accounts Receivable (A/R) is high and A/R aging contains old invoices
- Growing balance in Undeposited Funds
- Income is unreasonably high
- Bank account balance appears correct and may have been reconciled

When clients do not understand the mechanics of the cash collections functions within QuickBooks, they can quickly have a growing balance in Undeposited Funds. Often, the client enters payment received in the Receives Payments window correctly. However, these payments do not appear in the check register because the payment went to Undeposited Funds. The client will then often enter the deposit under Make Deposits, without selecting the payment from the Payments Received window, and post it to an income account. The customer account balances are not misstated and the bank account balance is correct and can be reconciled. Frequently, the client is unaware of the problem; however, Undeposited Funds and Income will be overstated.

The quickest and easiest way to locate Accounts Receivable errors is to review the A/R Aging Summary report. This report shows, at a glance, who owes the business money. The report can be collapsed to show the amounts due by customer, or expanded to show the amounts due by job.

Excessive amounts in the >90 days column can be an indication of incorrect posting: either from a QuickBooks data entry procedural issue or from a larger issue that could be indicative of a bigger problem with management. The incorrect posting issue is covered in this document.
By looking at the Open Invoices Report unapplied credits and payments can be identified. The report can be generated by selecting **Reports > Customers & Receivables > Open Invoices**. Where an invoice amount, then a payment or credit nets to zero, this is indication of an improper application of a payment.

**PURPOSE OF THE UNDEPOSITED FUNDS ACCOUNT**

The Undeposited Funds account is part of the suggested workflow for Accounts Receivable. Four common steps are typically used to processing Accounts Receivable transactions:

1. Create an invoice, sales receipt, or statement charge.
2. Receive customer payments.
3. Place payments into the **Undeposited Funds** account (preference settings will automate this).
4. Use **Make Deposits** to group multiple customer payments into a single deposit in the check register, which then matches the deposit amount on the bank statement.

The Undeposited Funds account is needed to hold payments received but not yet deposited. When clients receive checks from customers, they may put them in a safe and then later prepare the deposit slip and take them to the bank; the Undeposited Funds account simulates the safe. The Undeposited Funds account is a holding place for the checks and should zero out after deposits have been made at the bank.
UNDEPOSITED FUNDS ACCOUNT REVIEW
Before you begin analyzing the Undeposited Funds account balance, it is best to review the QuickBooks data file, concentrating on certain reports that will help to simplify the review process.

Creating an Undeposited Funds Detail Report
Creating a report of the Undeposited Funds detail will aid in the review of the Undeposited Funds. This is a custom report which is easy to create and highly useful.

The Undeposited Funds account is first affected when a Customer Payment is entered via Receive Payments. This payment increases the Undeposited Funds account. Next, a Make Deposit form is completed: QuickBooks reduces the Undeposited Funds account balance and behind the scenes marks both the original increase and the new decrease as cleared. The Cleared Balance column is indicated by a check mark in the Cleared column. The corresponding account in the Make Deposits window is to the Cash or Checking Account.

To create the Undeposited Funds Detail custom report, follow these easy steps:

2. Display the date range as All. (Tip: Simply type an “a” without the quote marks to make the date range default to All.)
3. For Total by select Payment Method from the bottom of the list.
4. For Columns, select those that you want to view on the report. You can leave the default columns checked and add or delete them by clicking the modify button later.
5. Click the Filters tab. On the filter pane select Account, and choose the Undeposited Funds Account from the drop-down menu.
6. Also from the Filters tab select Cleared and click the No button.
7. Optionally click the Header/Footer tab. Change the report title to Undeposited Funds Detail.
8. Once the report is opened, you can memorize the report for future use.
NOTE: The modified custom report you named Undeposited Funds Detail will always show the present state of the transaction, which means that when a payment is received and is included on a Make Deposits form, the report for a prior date will no longer show that item as Undeposited. Behind the scenes, QuickBooks is marking the transaction as ‘cleared’ as of the transaction date; therefore, you cannot get a historical snapshot.

This report can be reviewed to see if any transactions to Undeposited Funds have been recorded improperly somewhere else, such as directly into the bank account register. And as stated earlier, if the bank account has been reconciled prior to researching the Undeposited Funds balance, this process will be easier.
**UNDEPOSITED FUNDS ACCOUNT FIXES**

If the review of the data revealed payment transactions in the Undeposited Funds account that were not recent, two different methods can be used to fix the error as illustrated by the following case study.

*Deposit Data Entry Case Study*

Q – My accountant just informed me that I have been doing my deposits all wrong. I had been entering an invoice to send to the customer then receiving the payment to show the invoice was paid. I looked in the check register and did not see the money, so I entered a deposit which agrees to the bank statement. Now I have a big mess because the income has been recorded twice (once from the invoice and once from the deposit). What can I do now to fix the problem?

A – Two alternatives are available, depending on the volume of transactions.

The first is to "reconcile" the deposits as of specific dates; the second is to fix the detail.

The second solution will provide a clean trail, showing the transactions as if they were entered correctly the first time and "pulling" the received payments onto the deposit slips. This process can easily be done by using the **Clear up Undeposited Funds** tool available in Client Data Review (or manually).

The disadvantage to this process is that it can be more time consuming if there are numerous errors and you do not use the tool in CDR. However, if the deposit total does not change, none of the bank reconciliation work will be affected. Changing the deposit as opposed to deleting it preserves the bank reconciliation work.

The first solution mentioned is to make one deposit each month by checking off all the Receive Payments for a month and recording them onto one deposit slip. Then enter one line on the deposit slip as a negative amount coded to the general ledger account where the previous deposits have been recorded. The payments previously made to Undeposited Funds amount will now offset against the deposits which were made and incorrectly recorded to income.

**NOTE:** If the Receive Payment option has not been used (i.e., the invoices were entered and the deposits were then entered directly onto a deposit slip or into the register) and there was only one payment per deposit slip, the most efficient correction may be to change the general ledger account code on each deposit to Accounts Receivable and add the Customer name. A deposit slip only allows one line item coded to a general ledger account and a Customer, so if multiple payments were deposited together, one of the other options above would be needed. A second step of "linking" the invoice to the credit/payment would be required through the Receive Payments form.
**CLEAR UP UNDEPOSITED FUNDS ACCOUNT WITH CDR**

In Client Data Review, a Clear up Undeposited Funds tool helps find and fix Undeposited Funds errors. This tool is used to correct errors for Payments that are entered into QuickBooks but never carried through to a Deposit. The result is a payment as well as a manual deposit both being entered into the bank register. This tool allows you to match up the customer payments with the deposit entered to clear the Undeposited Funds account.

Below is an example of a deposit entered directly instead of selecting the payment from Undeposited Funds. The Deposit was entered and posted to the Construction Income:Labor account.
Using the Clear up Undeposited Funds tool within the Client Data Review, the payment can be applied to the deposit.
**NOTE:** When applying a Customer Payment to a Deposit in this window, the account previously entered is replaced with the Undeposited Funds payment (as illustrated below—the account is changed from the Construction Income:Labor account to the Undeposited Funds account.) The underlying accounting error is corrected and eliminates revenue from being recognized twice. Additionally, the deposit amount remains unchanged so the deposit remains reconciled, if applicable.

NOTE: If payments are unapplied from multiple customers and were deposited as one deposit, Client Data Review will *not* resolve it. These deposits will need to be fixed outside of Client Data Review. Client Data Review will only clear payments and deposits that are from the same customer.
FIXING NUMEROUS ERRORS IN UNDEPOSITED FUNDS WITHOUT CDR

An unwanted balance in the Undeposited Funds account can be fixed fairly easily without editing or modifying each transaction:

1. If the funds that remain in the Undeposited Funds account are more than one year old, first identify the total amount that was incorrectly deposited for each year.

2. Now "remove" these identified Undeposited Funds items by clicking Banking > Make Deposits. The Payments to Deposit dialog appears. Do not sort the transactions; instead, leave the View Payment Method Type as All Types. All payment types will then be listed and can be sorted by date within each payment type (see screen shot below).

![Payments to Deposit dialog](image.png)
3. Select all the payments for deposit with dates in the date range that need correcting by placing a check mark next to the payment item, as shown in the figure below, and then click OK.
4. The Make Deposits dialog opens with each of the previously selected payments included on the new Make Deposits form. On the next available line enter the account to which the incorrect deposits were originally recorded. In this example, the Construction Income account was overstated by the incorrect deposits. The effect of this new transaction is to decrease (debit) Construction Income account and decrease (credit) the Undeposited Funds account without any affect on the checking account as shown below.

![Make Deposits dialog](image)

This method corrects the overstated accounts (presumably income accounts) and reduces Undeposited Funds. (A ‘net zero’ deposit is made that clears out Undeposited Funds, and then debits the income account associated with the duplicate deposit entries made directly to the bank register.) To know what account to add to the deposit to subtract the amounts from, create a Custom Detail Report for Deposits to identify what accounts the deposits were applied to. If the deposits were not applied to a revenue account then revenue could be understated.

Once these errors are corrected, training in how to properly Receive Payments and then Make Deposits would be recommended.

**NOTE:** A task that should be completed before troubleshooting the Undeposited Funds detail is to reconcile the bank account. The review process is easier if the transactions that have cleared the bank can be identified along with the customer payment transactions that did not clear the bank in a timely manner.
Setting Preferences to Avoid Future Errors

A preference can be set in QuickBooks to use the Undeposited Funds account for all accounts receivable payment transactions. This preference is under the Payments Preferences as shown below:
If the preference shown above is not selected, the Undeposited Funds account should still be used on a customer's receive payment transaction as shown below.

Without the preference set, the payment will be posted directly to the bank account register. Adjusting the Preference at the Company level will ensure the customer payments always go to Undeposited Funds.

Reviewing preference settings with clients ensures that many important settings are set correctly and corresponds with how the client does business. Since many defaults are user specific, log in with the user name and then set the preferred defaults.
Correcting Multiple Jobs for the Same Customer

When customers have multiple jobs, clients do not always set jobs up correctly initially. See the example below where Family Room has been created and should have been a job under the Customer Abercrombie. Simply click on the Family Room Job and move it to the Right underneath Abercrombie. You will see the vertical black movement bar.
ACCOUNTS RECEIVABLE – SMALL OPEN BALANCES OR OPEN CREDITS

ERRORS & SYMPTOMS

Common Errors
- Payment not applied to an invoice
- Credit issued and not applied to an invoice
- Small balances need to be written off

Symptoms
- Accounts Receivable Aging Summary has a lot of aged balances and lines with zero or small amounts in the total column
- Open Invoices reports has many credits or small balances

Review the Accounts Receivable Aging Summary and the Open Invoices Reports to begin to clean up open payments or credits or write off small balances. From Reports > Customers & Receivables, both the Accounts Receivable Aging Summary and the Open Invoices reports can be run.

On the Open Invoices report, the date defaults to Today. Leave the date set to Today to avoid writing off an amount that was applied on a later date to another open customer invoice.

A review of this report will show payments or credits not applied to an invoice. The invoice and payment or credit is open although the customer balance may be zero resulting in a lengthy Open Invoices report.
**FIX UNAPPLIED CUSTOMER PAYMENTS AND CREDITS WITH CDR**

Within the Client Data Review feature is the Fix Unapplied Customer Payments and Credits tool. On the first tab, the Open Invoices are matched with the Customer Payments that have been received, but not applied to an invoice. To apply these transactions, select a name from the Customers tab, then on the **Invoices & Charges** tab, select a payment to apply to an invoice by placing a check in the check box. You can choose **Auto Apply All** to apply all of the payments or each Payment and Invoice can be selected individually, then choose **Apply**.

Once applied, the transactions will be grayed on this window until **Save** is selected. The transactions will not appear again the next time the tool is opened.
**Manually Cleaning up Open Items without CDR**

Clean up of a data file is often needed without the assistance of the tools in CDR. Also, if a Journal Entry was entered to Accounts Receivable, the CDR tool will not be of assistance. If deposits were entered directly to Accounts Receivable on the deposits and not to an income account, the CDR tool will not resolve the issues. To manually apply open items to invoices, use the following procedures.

1. Select **Receive Payments** and select the appropriate customer.

2. Leave the amount as zero and click on **Discounts & Credits**.
3. Within the Discounts and Credits window, select the Credit or Journal Entry to apply to an open invoice.
**WRITE-OFF SMALL BALANCES**

One method to easily write-off small balances occurs when the payment is recorded in the Receive Payments window.

1. From the Open Invoices report, simply double click on the invoice with the open balance.

2. Click on the **History** link at the top of the invoice to open the Transaction History dialog box.

3. From the Transaction History dialog, click the **Go To** button to open the Customer Payment window.
4. Select the option for **Write off the extra amount** shown below.

5. Once **Save & Close** is selected, the **Write Off Amount** window is displayed and the general ledger account to which the write off is to be charged appears. The account to which the amount written off is then selected. This account is typically an expense account such as discounts, bad debts or some other expense account.
Write off Invoices Tool in Client Data Review

CDR also has a Write Off Invoices tool, to write off numerous invoices, statement charges, or financial charges at the same time from a single window. This tool saves time and allows a quick clean up of accounts receivable.

NOTE: The Fix Unapplied Customer Payments and Credits tool should be used prior to the Write Off Invoices option. If credits are available, this warning message will appear.

This tool allows a group of specified invoices to be written off all at once to a specified account. Using this tool, multiple invoices can be written off quickly. Several simple steps are needed to write off the invoice.

1. First, create a list of invoices to be written off by entering criteria and then clicking Find All.

2. Fill in any of the criteria on the screen to limit the list, and then click Find All. If no criteria are selected, all open invoices appear on the list. The criteria selected will vary based on the client’s industry, the size of the client and a number of factors. The client will determine which invoices should be written off.

   The following criteria can be used:
   
   o Dates – There are four date options:
   o >120 days – invoice date is prior to today by 120 days or more
   o >180 days – invoice date is prior to today by 180 days or more
   o Review Period – invoice date is within the review period
   o Custom – invoice date is prior to the date you set in the Up to field

   NOTE: The Up to field is set automatically to 120 days before today, 180 days before today, or to the last day of the review period, depending on the selection, unless Custom is chosen.

3. Enter the date in the Up to field.

   o Balance Due less than – The maximum invoice amount to display on the list
   o Transaction Type – The type of transaction that an invoice must contain to display on the list. Valid types are Invoices, Finance Charges, Statement Charges, and all three.
NOTE: Click on the column headings in the table of invoices to sort the list by that column. If criteria has been used to limit the list of invoices that displays, the limited list is sorted by clicking a column heading. For example, setting the criteria to display invoices more than 180 days old and then sorting by customer name.

NOTE: If a customer has credit, the credit should be applied before writing off invoices. As shown above, the column Avail Credit/Pmt will display a blue link CREDITS for those customers with available credits. Click the link and the Fix Unapplied Payments and Credits window opens to easily apply credits to the open invoices.

4. Next, select the invoices to write off.

5. Click a checkbox next to an invoice to select it.
   - Click Select All to select all the invoices in the list.
   - Click Deselect All to clear all the checkboxes. After deselecting all the invoices, the selection process is restarted.

6. Specify the write-off terms.

7. Select the Write Off Account from the list. A write off account is required.

8. Change the write-off date, if necessary. A write-off date is required. By default, the write-off date is the last day of the review period.

9. Enter a write off class if class tracking is used.
10. Click **Preview and Write Off Selected Invoices**. A confirmation of the write off appears which shows all the invoices to write off, the write-off account, and the total amount to write off. Click **Write Off** to complete the write off process, or click **Cancel** to return to the main window.

**NOTE:** If the write off is canceled, the invoices are still selected. Click **Deselect All** to clear the selection, or continue working with the selected list.
Each invoice that is written off has a discount created and applied to it. A memo is added to the invoice and the discount transaction. All invoices written off through the CDR tool are tracked. To see the list of invoices changed, select **Audit Trail of Review** from the CDR center.

The transactions will be recorded as shown below.

### Customers and Vendors Are the Same

Clients often have customers and vendors that are the same entity. When sales to the Customer are generated, accounts receivable is increased and when items are purchased from the vendor, accounts payable is increased. While the two balances may offset each other, without action, they will remain on the books. Two remedies are available. The approach will depend on the volume of transactions that occur.

The first option is to create a bank account. It may be entitled something such as InterCompany. Determine which balance is lower, the amount in accounts payable or the amount in accounts receivable. Based on the lower amount, checks are written from the InterCompany account to pay the bills that are created and a corresponding deposit is made to the Accounts Receivable account for the same amount to offset the balance outstanding. The check and the deposit must always be for the exact same amount. Whatever balance remains either in A/R or A/P, is the amount either owed or due from the Vendor/Customer. The balance in the InterCompany account must always remain at $0.

The second option works the same as the option above, although a bank account is not created. A Credit Memo is issued for the amount of the Accounts Receivable that is being offset by the Accounts Payable and a Credit is issued against the bill for the same amount. Again, it is imperative that the Credit Memo and the Credit be for the same amount to facilitate an equal offset. An account must be charged on both the Credit Memo and the Credit. Using Other Income or Other Expenses is recommended. The transactions should net to $0 and not create a balance in either of these accounts.
ACCOUNTS PAYABLE ERRORS

ERRORS & SYMPTOMS

Common Errors

- Client enters bills and then writes checks
- There are unapplied vendor credits

Symptoms

- Accounts Payable balance is high with many aged bills
- Expenses seem unreasonably high
- The bank account balance appears correct
- Numerous unapplied vendor credits

The quickest and easiest way to identify Accounts Payable errors is from a review of the Accounts Payable Aging Summary report. The Accounts Payable Aging Summary report provides a quick snapshot of the outstanding bills as of a specific date. Most of the outstanding bills should be relatively current. An aged bill in the >90 days may indicate an error or a transaction that requires an adjustment. Consistently old outstanding bills can also indicate a profitability or cash flow issue. A vendor that appears on the report and has a zero balance in the total column indicates that all transactions have not been “linked” or credits have not been applied properly.

Excessive amounts in the >90 days column is an indication of either a data entry issue or a larger issue that would require involvement of the management of the business.

[Image of Accounts Payable Aging Summary report]

The table shows the Aging Summary report for Rock Castle Construction as of December 31, 2011. The report categorizes bills by their due date and provides the total amount for each category. The report highlights bills that are past due and indicates the need for attention.
**Fix Unapplied Vendor Payments and Credits**

In Client Data Review, the Fix Unapplied Vendor Payments and Credits tool corrects accounts payable posting problems. This feature works similar to the Unapplied Customer Payments to Invoices. Here, checks have been written to Vendors instead of bill payments being used. Therefore, bills are still shown as outstanding even though checks have been written to the vendor or outstanding vendor credits are available but have not been applied to the bill. Checks and Vendor Credits are applied to bills in the same fashion as customer payments were applied to invoices as described in the Accounts Receivable section of this document.
**CHECK WRITTEN INSTEAD OF PAY BILLS**

Accounts receivable issues often arise when clients first use Enter Bills to record an amount due but then use Write Checks instead of Pay Bills to pay these bills. Typically, the client would record the check to the same expense account used when the bill was recorded resulting in expenses being doubled. The Accounts Payable account would also be overstated and contain numerous old, unpaid bills which had in fact been paid.

Messaging has been improved in the latest versions of QuickBooks, encouraging users to **Go To Pay Bills**, however, this error may still occur. Two items to consider before deciding how to correct the problem are, first whether the client is on the cash or accrual basis of accounting and second whether or not the bank account has been reconciled.

**ACCRUAL BASIS – NO BANK RECONCILIATION**

If the client uses the accrual basis of accounting and the bank reconciliation has not been completed, the incorrectly entered checks can be simply deleted and the checks re-entered using the Pay Bills function. Deleting transactions quickly is easy using the CTRL-D shortcut. Backing up the data file before making substantial changes is always encouraged. Also, a check register should be printed or check copies should be available to enable rerecording of the checks. The checks should first be reentered using the Bill Pay functions, then the checks appearing as a duplicate, not written as a bill payment can be deleted. Reentering the bills first will preserve the original input information, if it is needed, while entering the bill payments.
**Accrual Basis – Bank Reconciliation Completed**

For clients who use the accrual basis of accounting, the dates recorded on bills and bill payments are critical for proper reporting. If a payment to a vendor has already been entered as a check, not a bill payment check, and the bank reconciliation has been completed, deleting the check as described above will require redoing all of the bank reconciliations as far back as transactions are affected. This can be a very time consuming and tedious process. For this reason, the best solution is to change the account code on the check to *Accounts Payable*, ensuring that in the column entitled *Customer:Job* the vendor name is entered. A credit is created that can then be linked and offset to the bill that was created.

**Step 1 – Correct Coding of Check**

In the Vendor Center, locate the check that was entered incorrectly and edit the check changing the account to *Accounts Payable* and including the vendor name in the *Customer:Job* field as illustrated below.

![Edit Check](image)

Record the change. Complete this same procedure for all checks that should be linked to a bill.
**Step 2 – Link Check to Bill**

Next, go into Pay Bills and select the appropriate bill to pay and click on **Set Credits** as shown below.
Within the **Discounts & Credits** screen, select the appropriate credit, which will be the check that was just edited, to be applied to the Bill. (Note that the check number is in the reference field).

![Discount and Credits](image)

The credit will be applied to the bill and the **Amount to Pay** will then be zero. The transactions are then linked together.

Continue this process for the bills and checks that have been corrected and need to be linked. When the process is complete for all the transactions, click on the **Pay & Close** button. The Ending Balance for the Bank Account will not change.

A dialog box will appear that affirms that no checks will be generated.
CASH BASIS – BILLS NOT NEEDED
If the client maintains their accounting system on the cash basis and accrual basis reports are not used or needed for management, historical or any other purpose, deleting the bills is easily accomplished. A review of the accounts to which the checks are recorded is recommended as the information recorded on the bill will no longer exist. If the client uses job costing, ensure the checks also have the job costing information recorded before the bills are deleted.

The easiest way to delete the bills is to go to the Accounts Payable register and delete them. The Accounts Payable register can be opened by going to the Chart of Accounts, selecting the Accounts Payable account and double clicking. Use the CTRL-D shortcut to quickly delete the unwanted transactions. If the bill has been paid, a dialog box appears with a warning message. If the warning message appears, cancel the deletion and investigate the checks applied or partially applied against the bill.

A review of the Unpaid Bills Detail report from Reports, Vendors & Payables, Unpaid Bills Detail can confirm that the remaining unpaid bills are what should be remaining in accounts payable.
PRINTING 1099-MISC FORMS
Clients often have difficulties printing 1099-MISC forms. The process is simple and easily performed.

1. First, as vendors are established, their Federal ID numbers should be entered on the second tab of the Vendor Information. If the Vendor Eligible for 1099 box is checked, then a Federal ID number, either a Social Security Number or an Employer Identification Number must be entered before the Vendor can be saved.

![Vendor Information Screen]

The Vendor Information screen shows fields for entering a Federal ID number and setting the Vendor Eligible for 1099 checkbox.
2. Second, the accounts to which payments are made and for which 1099s should be generated must be identified. Under **Preferences**, the **Tax:1099** option is opened and the accounts to which payments are made that should be reported on the 1099-MISC are selected. While currently these mostly include Labor and Rent accounts, legislation as currently enacted will require reporting of a wider class of payments to more vendors in future periods. If 1099-MISC forms are required to be sent to vendors for more than just labor or services in the future, additional accounts will be added in this section.

3. To print the 1099-MISC forms, from the **Vendor** menu, select **Print 1099s/1096**.
4. The 1099 and 1096 Wizard will be displayed and will step you through the process of generating the 1099 forms. Proper set up of the Vendors and mapping of the accounts will aid in resolving some of the issues that occur when trying to print 1099s.
CREDIT CARD ERRORS

ERRORS & SYMPTOMS

Common Errors

- The client only makes partial payments on its credit card bills
- Accounts Payable is used to enter bills for revolving debt balances
- All credit card bills are recorded to the same expense account
- Credit card accounts are not reconciled

Symptoms

- Accounts payable balance is high with numerous credit card bills
- Expenses seem unreasonably high
- The bank account balance appears correct

The credit card errors discussed here involve the credit cards clients possess and use to make charges and pay for expenses. An account should be established for each credit card the client has for its business. The type of the account will be Credit Card. This is different than a debit card that is tied to a bank account. All debit card transactions should be entered directly into the bank account’s check register, not via the Credit Card account type.

Often, clients will not want to enter or download the individual charges that appear on a credit card statement. Instead the client wants to enter one summary transaction for all charges appearing on the bill. This is easily accomplished after the client has summarized the transactions for the bill. A Credit Card account is still established and from the Banking menu, Enter Credit Card Charges is selected to enter the transaction. One charge is created with the detail of the credit card statement from the client’s summation being entered as one credit card charge. An account line item is added and the total charges for each account type are entered. Advise the client that when using this manner of recording charges and payments, the date of the credit card charge is the date the financial statements will be affected. If the credit card statement covers more than one month or accounting period, two entries might be desired to properly account for the dates of the transactions.

Clients that pay a credit card statement in full can shortcut the process by simply entering the total of the credit card statement as one bill, again after summarizing the charges for segregating to the proper accounts. Entering a bill is only recommended when the credit card bill is paid in full each and every month. Otherwise, the accounts payable balance will be intermingled with growing and longer outstanding credit card balances.
CREDIT CARD TYPE ACCOUNT

Credit Card type accounts should be used for many reasons. The reasons include:

- A reconciliation process that includes reconciling to the credit card statement from the credit card company similar to reconciling a bank statement.
- Accounts Payable Aging Reports and due dates are not distorted when the entire balance of the credit card statement is not paid in full.
- Credit card charges are typically deductible for income tax purposes when the charge is made regardless of whether the credit card company has been paid or not. If bills are used to record the credit card transactions, these transactions will not be reported on accrual basis financial statements.

CREDIT CARD TRANSACTION ENTRY - ONE ENTRY OR MANY?

The first step in using the credit card feature is to enter the charges and credits. The charges and credit can be entered as the credit card is used to pay for the purchase of goods and services or later.

- Entering the individual charges as the credit card is used or downloading them via Online Banking will give the client real time financial information and can be an added internal control to ensure that all credit card transactions are supported with a receipt.
- For some clients, this level of effort in recording these transactions is not feasible. Instead, clients enter one credit card charge with the total credit card charges and credits. The credit card charges will have to be summarized by account type to be entered in detail as a credit card charge.

Using a consistent method to record the charges is important. Often, a client will not pay its entire credit card balance occasionally. Entering the credit card statement as a single will create a challenge in those months when the balance is not paid in full.
**CREDIT CARD RECONCILIATION**
Credit card statements can be reconciled in a process very similar to the bank reconciliation. When the credit card statement arrives, the statement should be reconciled to the charges. Finance charges can either be entered as a charge or during the reconciliation process.

The bank account reconciliation ensures all transactions are recorded. Credit card reconciliation facilitates the process of making a credit card payment. Once the statement has been reconciled and the **Reconcile Now** option has been selected, a dialog box appears to provide an alternative to enter a check to pay the credit card statement in full or to enter a bill to pay the credit card later (see image below). The amount that will be paid will be entered.

**EXTRA PAYMENTS**
Occasionally, business owners will make an additional payment other than the monthly required payment to pay down the balance due. Since a check or bill for the additional payment will not be created as part of the reconciliation process, a check or bill must be entered and coded to the credit card account. This will reduce the outstanding balance of the credit card. The payment will appear on the next credit card reconciliation that occurs.
SALES TAX ERRORS

ERRORS & SYMPTOMS

Common Errors
- Clients Write Checks (or uses the check register) to pay sales tax liabilities
- Sales taxes not set up properly

Symptoms
- A growing balance in sales tax payable and sales tax expense
- The Pay Sales Tax dialog does not show previous payments
- Sales taxes are not calculating properly

Several steps are involved to ensure that sales taxes are set up correctly and properly processed.

Sales Tax type items in QuickBooks facilitate charging the proper tax rate to customers and record the liability to the taxing authority to which the sales tax is to be remitted.

Sales Tax Codes facilitate designating the taxable status of the products and/or services that are sold and the taxable status of the customer. Sales tax codes also facilitate reporting on multiple types of non-taxable sales.

Sales Tax Groups are optional. In many jurisdictions, sales tax is composed of a collection of state, county and local rates. While the breakdown of the tax collected must be reported to the taxing authorities, the customer need only see the total tax rate charged.

The first step in the proper set up of sales tax is to create the individual city, county, and state sales tax items, and then assign them to a Sales Tax Group item type. The Sales Tax Group item is then assigned to the customer. QuickBooks currently does not produce a report that contains the sales tax by sales tax group. If sales by Sales Tax Group are needed for sales tax reporting, use of the Sales Tax Groups is not effective.
REPORTS TO REVIEW PROPER SALES TAX LIABILITY BALANCES
Sales tax reports should be reviewed each time sales and use tax is to be reported to the taxing authority.

Reviewing Customer Lists for Tax Code and Tax Item Assigned
The taxable status of customers should be verified on a regular basis. A report is easily prepared to facilitate the review of customer’s taxable status.

1. Click Reports > Lists and select the Customer Phone List report.
2. Click the Modify Report tab on the top left of the window.
3. In the Display dialog that opens, in the Columns pane, click to place a check mark next to items you want to review for the list, including Sales Tax Code and Tax Item, and include the Resale Num if you track this number for your wholesale customers.
4. Optionally, select Sort By at the top right, and from the drop-down list select Sales Tax Code.
5. Optionally, click the Header/Footer tab to change the report title.
6. From this list (shown in the figure below) you can conveniently double-click any line item detail to open the Edit Customer dialog and make any needed changes.
7. Memorize this report for regular use.

NOTE: When a change is made to a customer's assigned tax code or tax item or to the tax code assigned to a product or service on the item list, prior saved transactions will not be updated, new transactions will contain the new sales tax status or rate. Prior transactions than need adjustment will have to be changed item by item.
**Reviewing Item List for Tax Code Assigned**

The list of services and products that are sold should also be reviewed on a frequent basis to ensure that the proper tax codes have been assigned to them. A report can be generated to easily review these tax codes.

1. Click **Reports > Lists** and select the **Item Price List** report.

2. Click the **Modify Report** button at the top left of the report.

3. In the Display dialog that appears, remove check marks from those data fields that do not need to be displayed on this report. Place a check mark next to the fields that should be included on the list, including **Sales Tax Code**.

4. Optionally, select **Sort By** at the top right, and from the drop-down list select **Sales Tax Code**.

5. Optionally, click the **Header/Footer** tab to change the report title.

Prepare a report of the items and the sales tax codes assigned to them to verify the accuracy of your setup.
Reconciling Total Sales on Sales Tax Payable to Total Income on Profit & Loss

Total sales reported for sales and use tax purposes should be reconciled to the sales and use tax reported to the sales and use tax reporting agency. In the case of a sales and use tax audit, reconciliation of these amounts will most likely be necessary.

To compare total sales on the Sales Tax Liability report to total income on the Profit & Loss Report:

1. From Reports > Vendors & Payables, select the Sales Tax Liability report.
2. From Reports > Company & Financial, select the Profit & Loss Standard report.
3. Compare sales on the Profit and Loss report to the total sales from the Sales Tax Liability report. Non-sales income items may require adjustment in the reconciliation process on the Profit & Loss Total Income amounts.
4. To locate other discrepancies, review the sales account assigned to items on the Items list.

When Total Sales Does Not Match Total Income

What can cause total sales on the Sales Tax Liability report to not match total income on the Profit & Loss report? Some of the reasons might be the following:

- **Different accounting basis between reports** — The Sales Tax Liability report basis is in conflict with the Profit & Loss reporting basis. The basis of the report is by default printed on the top left of the report. Both reports must be either Accrual Basis or both must be Cash Basis before comparing.

- **Non-sales transactions recorded to income accounts (i.e., other than Invoices, Sales Receipts or Statement Charges)** — One method to locate these transactions is to double-click the total income amount on the Profit & Loss report. Doing so opens the Transaction Detail by Account report. At the top right of the report, select Sort By and choose Type. Within each income account group, transactions are sorted by transaction type. Review the report for non-sales transaction types such as General Journal or Bill (to name a few). If you find a Bill on this report, items may be set up improperly.

- **Income recorded as a result of vendor discounts** — If an income account was set up for vendor discounts in the bills preferences setting, this amount must be deducted from the total revenue to compare the two totals. A separate income account for these discounts will allow them to be easily tracked.

Additionally, the preference settings need to be set properly depending on whether the sales taxes are remitted to the taxing authority on the Accrual Basis (sales tax due based on date of invoice) or Cash Basis (Sales Tax Due based on date of customer payment).

Reconciling Sales Tax Liability to Balance Sheet Sales Tax Payable

Another equally important comparison to make is between the balance on the Balance Sheet Sales Tax Payable amount and the amount showing payable on the Sales Tax Liability report.
The Sales Tax Payable accounts are created automatically during setup of a new client file if the Questionnaire is used and the client indicates that sales tax is to be collected and remitted. If the Sales Tax Payable account is not set up properly, comparison of the two reports may not work. QuickBooks creates the Sales Tax Payable account automatically.

To compare the Balance Sheet Sales Tax Payable with the Sales Tax Liability report:

2. On the report, select the As of date for the end of the period to compare to; this date must be the same ending date as the Sales Tax Liability report in the next step.
3. Click Reports > Vendors & Payables and choose the Sales Tax Liability report. QuickBooks will default the date range depending on the sales tax preference setting.
4. Balance Sheet Sales Tax payable should agree with the Sales Tax Liability report.

Each month, before preparing the sales tax return, the comparison described above should be performed to identify potential errors with the sales tax liability.

Look for transactions such as General Journal entries (as shown above) that will affect the sales totals but will not be included in total sales on the Sales Tax Payable report. If a check is written and coded to the Sales Tax Liability account, the Sales Tax Liability function has not been notified and relieved, so Sales Tax will still show as due on the Sales Tax reports. The following section details how to make the necessary corrections.
CORRECTING SALES TAX PAYMENT ERRORS
Fixing certain aspects of sales tax errors can cause ripples throughout the entire data file. Before making some of the following corrections, consider the following:

- Has a backup of the data file been made?
- Have taxes or financials been prepared using the data in its current state? If yes, then be cautious about changing dates and the other types of the corrections you make.
- If the sales tax reports created show a sales tax due amount that is incorrect, has the amount which should be due been determined?

Print the sales tax reports before making corrections to the data file. Then make a backup of the company data file. Only then should the corrections be made and the report printed again. Compare the original report and the report after the corrections for agreement.

FIND AND/OR FIX INCORRECTLY PAID SALES TAX
Another Client Data Review tool, finds and fixes incorrectly paid sales taxes by voiding the improper payment and replacing the check with a sales tax liability check all while maintaining the cleared status of the original check.

QuickBooks displays an error message when users attempt to pay vendors set up as the sales tax vendor incorrectly. If a user tries to pay a vendor that is associated with a sales tax item, or to use the Sales Tax Payable account in the Write Checks window, QuickBooks provides the warnings shown below.
NOTE: If the user checks the ‘Do not display this message in the future’ box, then the warning will not display prospectively. This message can be brought back, along with all one-time messages by editing the General Preferences as shown below.

If a sales tax liability payment was made by a check, first determine whether the check has been cleared in the bank reconciliation; if the check has not been cleared through the bank reconciliation process, simply void the check and re-create the check using the Vendors, Sales Tax, Pay Sales Tax option (using the same check number, date, and amount).
If the check has already been included in the bank reconciliation, use the following steps to properly assign the sales tax payment check or bill to the line items in the Pay Sales Tax dialog:

1. Select the check from the steps listed in the previous section. Double-click the check to open the Write Checks dialog.

2. If not already assigned, assign the Sales Tax Payable liability account in the Account column of the Expenses tab.

3. In the Customer:Job column, select the Sales Tax Vendor (the entity to which the sales tax is due) from the list of vendors. This must be a vendor and not a name in the Other Names list.

4. Click Save & Close to close the check form.

5. Select Vendors > Sales Tax, and choose the Pay Sales Tax option.

6. Place a check mark next to each sales tax line item, including the line item with the correction to associate the check form with the sales tax due. (See the figure below). The net total amount of the transaction should then be zero. If the Totals is not zero, an adjustment may be needed to record items such vendor’s compensation. A discussion on how to make a sales tax adjustment is below.

This process enables the corrected check to be assigned to the sales tax liability without issuing a new check. The net entry is zero, so no check will be issued.
**ADJUST SALES TAX PAYABLE**

The Adjust button can be selected from the Pay Sales Tax window. The Sales Tax Adjustment window will appear. All adjustments to sales tax should be made through this window and not by using a Journal Entry. Using a journal entry does not affect the amounts displayed in the Pay Sales Tax window though the entry does post to the general ledger.

![Sales Tax Adjustment Window](image-url)
PAYROLL ERRORS

ERRORS & SYMPTOMS

Common Error

- Clients Write Checks (or use check register) to pay payroll tax liabilities

Symptoms

- Payroll Liabilities are higher than expected
- Payroll Tax Expense is higher than expected
- Bank account balance appears correct
- Payroll tax returns have been prepared and filed showing no balance due (and no notices to the contrary have been received)

Payroll, (and inventory discussed elsewhere), are two areas where QuickBooks is less forgiving and clients are more likely to make mistakes. Most often the errors are the result of incorrect or inconsistent procedures.

The most common error in this area is that the Pay Payroll Liabilities feature was not used; rather payroll tax payments were entered using Write Checks or Enter/Pay Bill functions.
WARNINGS REDUCE ERRORS

QuickBooks does warn users in several instances when the recommended procedures are not followed. If users heed the warnings, errors are often avoided. However, some users will click past these warnings and still process the payroll incorrectly perhaps for a lack of understanding as to how to do otherwise.

A client must first subscribe to one of Intuit’s payroll offerings for payroll to be established. Once payroll is installed, a Payroll Setup Tool walks the client through the process.

QuickBooks payroll works best when all payroll activity is performed from within the payroll menus. This includes paying accrued payroll taxes to the respective taxing authorities. If the company has written checks or used the Enter/Pay Bills entered bills functionality to pay for these liabilities, and the QuickBooks-created Payroll Liabilities account was assigned, the following warning message appears:

This message warns but does not prevent users about using the wrong type of payment (i.e., Write Checks or Enter/Pay Bills) when attempting to make payroll liability payments. When the user clicks the Pay Payroll Liabilities button in the warning message, the user is directed to the Select Date Range for Liabilities dialog. The message directs the user to use the Pay Payroll Liabilities feature to create a payroll liability check.
**FIND INCORRECTLY PAID PAYROLL LIABILITIES**

In the Client Date Review, the **Find** Incorrectly Paid Payroll Liabilities tool, generates a report of all the manual check transactions coded to a Payroll Tax vendor. The entries made outside of the Pay Scheduled Liabilities function in the Payroll Center are displayed.

![Image of Transaction List by Vendor]

**Correcting Payroll Liability Payment Errors**

Payroll tax liability payments can be corrected via two methods. First, if a check or bill payment was used to pay a payroll liability, determine if the check or bill payment check has been cleared in a bank reconciliation. If not, void the existing check or bill that is paying the payroll liabilities and recreate the check correctly by selecting **Employees > Payroll Taxes & Liabilities**, then **Pay Scheduled Liabilities**.

The second method should be used if the check or bill payment check was used and that check has been cleared in a bank reconciliation. If the check or bill payment check is voided, the bank reconciliation will be affected. Using a Journal Entry is never a preferred method to make the correction, instead the Payroll Liability Adjustment option should be used to make the correction.
GETTING THE RED OUT—CLEARING OUT PAST DUE LIABILITIES

The Pay Scheduled Liabilities section in the Payroll Center may have red overdue amounts showing when none exist. The liabilities amounts appear in the section when a payroll is generated and are only reduced when the Pay Scheduled Liabilities method is used to pay the taxes due. If the liabilities were recorded through any other method, such as a check being written and coded to the Payroll Liabilities account, the liabilities shown as due will not be reduced.

1. First, verify that the liabilities have been paid.

2. Select the appropriate item from the Pay Scheduled Liabilities window as shown below and click the **View/Pay** button.
3. In the Liability Payment - Checking window, change the check amount to zero.

4. Add additional lines in the expenses area for the same accounts already listed with a negative amount to offset the entry.

5. Include the check number actually used to pay the liabilities in the memo section as a reference.

6. The result will be offsetting amounts to the liabilities accounts which will clear the Pay Scheduled Liabilities window, but not affect the general ledger accounts.
ADDITIONAL AREAS TO TROUBLESHOOT PAYROLL ERRORS

Importance of Payroll Item Account Mapping

Payroll items must be assigned an account so payroll transactions can be properly recorded in the general ledger. Errors in the set up of the payroll item mapping can be located through a Payroll Items Listing report. Select Reports > Lists > Payroll Item Listing report. This report shows the payroll earnings, deductions, and tax items as well as the current tax table limits and rates. Use this report to ensure the desired General Ledger account is being used. Double-click on any item to make changes. Changes can be applied to all transactions, future and prior, only prior transactions from a date forward or no prior transactions.

Reconciling Payroll Transactions in the Bank Reconciliation Process

The Intuit payroll subscription will determine whether all federal and state payroll tax forms for filing are available within QuickBooks. If you or the client is preparing the payroll, it is wise to first complete the bank reconciliation to determine any payroll liability payments which have not cleared and handle them accordingly.
LOCATING NON-PAYROLL TRANSACTIONS

Users sometimes override error message and record transactions that should appear on payroll reports. Identifying these before the payroll tax returns are prepared and filed can save the time to amend or correct these payroll returns later on.

From the Employees menu, choose Employee Center, then the Transactions tab. From this area, select the Non-Payroll Transactions and in the Date area, select the time period for which the payroll reports are being generated.

Shown in the example below is a non-payroll check issued to Gregg. While the check may be recorded properly, this check may also be recorded improperly. This review will make that determination.
CREATING PAYROLL LIABILITY CHECKS DIRECTLY IN THE CHECKBOOK REGISTER

To properly process payroll liability checks, select Employees > Employee Center > Payroll tab, then View/Pay Scheduled Liabilities. Payroll Liability checks should be generated from this section. However, checks are often created directly from the register or via Write Checks. The Pay Scheduled Liabilities section in the Payroll Center is then incorrect. See the Getting the Red Out—Clearing out Past Due Liabilities section earlier for step by step instructions on how to correct these entries.

If the liabilities need to be adjusted and the bank account has been reconciled in QuickBooks, another way to correct the liability is by selecting Employees > Employee Center > Payroll tab and choose Related Payment Activities > Adjust Payroll Liabilities. The Liability Adjustment window appears and changes can be made either to or not to affect the General Ledger accounts depending on how the checks to pay the liabilities were originally written.

NOTE: Choose Do not affect accounts if the General Ledger is correct overall and should not be affected. This situation would arise if the client paid the correct amount of the payroll liability and used the correct General Ledger coding on the checks written to the taxing authorities, but simply did not write the checks correctly using the Pay Scheduled Liabilities area of QuickBooks.

In the example shown above, we are choosing to affect the Liability and Expense Accounts. The following dialog box appears. The general ledger will be update with the adjustment.
INVENTORY ERRORS

ERRORS & SYMPTOMS

Common Error

- Incorrect and/or inconsistent inventory procedures

Symptoms

- Inventory Valuation Summary report shows negative quantities
- Inventory Valuation Summary does not agree to General Ledger
- Average cost appears incorrect
- Asset value does not agree with the General Ledger

Inventory, like payroll, is consistently one of the most problematic areas for clients. A rigid set of procedures, with everyone inputting data consistently and in a timely manner is crucial. This often opens an opportunity for training.

The fundamentals should be reviewed initially. First, evaluate whether the Inventory items are set up properly. Clients often set up items as type - inventory when they would be better served using the non-inventory item type. The non inventory type does not keep a perpetual count or an average cost.

Second, evaluate whether the total inventory value on the inventory valuation summary report agrees to the inventory amount reported on the Balance Sheet. Disagreement in these two numbers can be caused by several factors. A CDR tool can assist with this problem.

Third, review the Inventory Valuation Summary for negative quantities and inaccurate average costs.

CDR Tool—Compare Balance Sheet and Inventory Valuation

The only method available in QuickBooks for inventory valuation is average costing. An Inventory Valuation Summary Report summarizes the quantity, average cost and extended value of each of the inventory quantities and provides a total inventory valuation. The total asset value on this report should match with the Balance Sheet value for Inventory, just ensure these two reports were created with the same time/date settings if other users are entering data in QuickBooks at the same time.

If Journal Entries have been posted to the inventory account, the Inventory Valuation Summary will not agree with the Inventory Asset balance on your Balance Sheet. Additionally, inventory items with Quantity On Hand that have been made inactive will also cause a discrepancy between the Inventory Valuation Summary report and the totals for the inventory asset account on the financial statements or trial balance. To correct this problem, re-activate the inventory item, create an inventory adjustment (as discussed below), then inactivate the item again.
The Compare Balance Sheet and Inventory Valuation tool within CDR determines whether the inventory account on the Balance Sheet and the Inventory Valuation Summary match. The tool compares the inventory general ledger account with Inventory Valuation Summary and displays the results.

A green circle indicates that the inventory account in the general ledger agrees with the Inventory Valuation Summary.

A yellow warning triangle alerts that a discrepancy between the inventory general ledger account and the Inventory Valuation Summary exists. Two major causes of discrepancies are non-inventory accounts affecting inventory transactions and the incorrect setup of the accounts for inventory items.

The default date for the comparison is the last day of the review period specified in the CDR. The date in the As of field can be changed and then Refreshed to narrow down the date when the discrepancy occurred.

If the tool shows a discrepancy, links are provided to items that can help resolve the problem.
Most Common QuickBooks Mistakes and How to Fix Them

Links to the Balance Sheet and Inventory Valuation Summary

A link to a report that shows Transactions using an inventory asset account but not inventory items allows you to see a report that lists all transactions (such as a Journal Entry, Check or Bill) posted to the Inventory Asset account that did not affect an inventory item. For checks or bills, the transaction should be edited to include the inventory item on the Item tab and the transaction information on the expenses tab removed. If a journal entry posted to the inventory asset account, then the Journal Entry needs to be deleted or voided and an inventory adjustment made for the appropriate item.

There are also links to:

- The Add/Edit Multiple List Entries window to review the inventory setup
- Adjust Inventory Quantity/Value on Hand
- The Item List

CDR Tool—Troubleshoot Inventory

Improperly recording the purchase or sale of inventory items in QuickBooks can cause many problems. Having a negative quantity for an inventory item is also a problem, and can affect how QuickBooks calculates average cost. Identifying the specific item and/or transaction that caused the negative inventory situation can take a considerable amount of time.

The Troubleshoot Inventory tool will help find inventory errors. A column in the tool displays a Yes if a negative value occurred as of the end of the period or any time during the review period. Another column shows inactive items that have a quantity on hand and another column shows items with a percent of markup that is less than the amount specified.

- **Tool Options** – The item list is show in spreadsheet format. Filter options are displayed on the top left. The Columns to Display option is on the top right and a link to the Adjust inventory Quantity/Value on Hand adjustment window is located at the bottom of the window.
• **Filter Options** – Items can be filtered for all or only active items, Negative Quantity, Inactive items with Quantity on Hand, and a % of Markup less than a specified percentage.

• **Marking items as inactive** – Items can be marked as inactive directly from this window. Check mark which items you wish to mark as inactive and then click Make Selected Items Inactive.

• **Negative Inventory** – Negative Inventory is indicated by a yellow warning sign and a Yes/No message in the far right column. Double click on the amount showing as negative and the Inventory Valuation report appears. Note: this tool does not have the ability to automatically fix negative inventory as the fix can vary from situation to situation. However, an adjustment can be made to the inventory items by clicking the Adjust Quantity/Value on Hand link on the bottom of the window. Negative inventory alerts can also be displayed by the As of date or Any time in date range by selecting the desired option in the bottom right corner of the window.

• **Customizing Columns** – Click on the Columns to Display link to customize the format of the spreadsheet. Note: by default all available columns are marked so the available columns are displayed and unwanted columns can be removed easily from this window. To remove a column, simply click on the check mark next to the column name and click Save.
INVENTORY FIXES

Items Overview

Within QuickBooks, an item can be anything bought or sold by the business. Think of an item as anything that you will purchase and then later sell. The item is the underlying link between invoices and bills or checks to the general ledger. Sometimes a multitude of items is needed for small variations amongst items sold, and sometimes one generic item will due when the item sold is actually slightly different. That determination is made based on the level of detail needed by management and the potential differences in cost of the items purchased and sold. For example, if the business sells pizzas, one item is all that is required. As each invoice is created, the description and price could be revised as needed. The other alternative would be to create items for each of the different kinds of pizzas sold. This approach would eliminate the need for revisions as the invoice is created since the description and price would come up automatically. More sophisticated sales reports would also be possible in the latter example.

There are many judgment calls and different ways to achieve accurate general ledger results. Review of the item list is critical to:

- Confirm that the items have been set up correctly and
- Confirm that the decisions made are appropriate for the business based on the flow of paperwork, accounting knowledge, QuickBooks experience, etc.
**Item Types**

When creating an item, several choices of item types are available. The type is also important for subtotals on reports and for some function options.

Below is a list of the types and the typical use for each:

- **Service** – most commonly used for items such as labor, consulting, hourly fees, etc. A service type item is required for use on timesheets.

- **Inventory part** – items normally carried in stock until sold. This item type will keep a running balance of quantity on hand and moving average cost. This item type will record purchases into an Other Current Asset account when purchased and record a corresponding entry with each invoice to record the appropriate amount to cost of goods sold. Further detailed discussion of this type of item is beyond the scope of these materials.

- **Inventory Assembly** – items created from other inventory items (i.e., assembled) then carried in stock until sold. This item type will keep a running balance of quantity on hand and moving average cost. This item type will record purchases into an Other Current Asset account when purchased and reclassify the appropriate amount to cost of goods sold when an invoice or cash sale receipt is created. Further detailed discussion of this type of item is beyond the scope of these materials.

- **Non-inventory part** – items not kept in stock. This could include items such as custom or special orders. This item type is also used if the average cost method of valuing inventory is unacceptable or perpetual inventory counts are not necessary. As items are purchased, they are simply expensed.

- **Other Charge** – freight, service charge, fuel surcharge, gift-wrapping services or other expenses that are passed through to the customer are all examples of other charge type items.

- **Subtotal** – a special item type that permits a subtotal line on an invoice to accumulate the amount due of all lines entered previously.

- **Group** – this item type is used when several items are sold at the same time. The group item adds flexibility for printing all of the individual components on the customer’s copy of the invoice, or showing the detail only on the screen with one line on the printed copy of the invoice that merges the detail together. Note: Reports cannot be run on groups by themselves. For example, if an installed door set is sold that includes a door, the hardware, and labor, a sales report will show the appropriate amount of revenue for each component but will not show the revenue generated from the sale of the door set group itself, only how many components were sold.

- **Discount** – a reduction on the invoice that can be either a flat dollar amount or a percentage of the line immediately preceding it. If a discount is to be given on each item, the discount will be entered either after each item, or once after a subtotal of all items.

- **Payment** – if a payment is received at the time of the invoice, this item type can be used. If the Client uses statements, then the statement will only show the net of the transaction, not the detail. If it is important to show the payment on the statement, entering an invoice then creating a receive payment transaction may be preferred. The Payment item type can also be used for client’s whose customers prepay or make deposits.
• **Sales Tax** – based on the customer being taxable, and the item being taxable, this item will calculate the tax liability due based on the tax percentage entered.

• **Sales Tax Group** – a group of Sales Tax items that allows the business to show one tax rate, comprised of a state, county and/or local sales tax item, as on item on an invoice or sales receipt. Currently, a Sales Tax Group report is not available within QuickBooks. The absence of this report makes this type item not a preferred method for tracking sales tax.

**Inventory versus Non-inventory Type Parts**

QuickBooks only reports inventory based on average cost. QuickBooks tracks inventory well when set up correctly and proper procedures are followed consistently for buying, selling and adjusting the inventory item balances. The premise behind this is properly setting up inventory versus non-inventory types.

The item types were defined above; however, a description of best practices is warranted.

With inventory, one item is coded to an asset, a cost of goods sold account, and an income account. As the items are purchased, they are recorded on the items tab of a bill, check or credit card charge) and the inventory balance is increased for the quantity and cost of the item. When the item is sold, the average cost is deducted from the inventory asset account and recorded in cost of goods sold. At the time of the purchase, the inventory account is debited and the bank account, accounts payable or credit card account is credited. At the time of the sale, the journal entry that takes place is a debit to accounts receivable and a credit to sales, but also, a debit to cost of goods sold and a credit to inventory at the average cost computed by QuickBooks.

With non-inventory parts, only one account is typically used both for the purchases and sales. The item can be edited and the check the box in the middle of the item marked. This opens two sections of information versus the prior one section. Now information for both the purchases and the sales accounts can be entered. With non-inventory type parts, at the time of the transaction the purchase is expensed and the sale is recorded as income. The inventory account is not involved.
Items can be changed for coding corrections, or to change a non-inventory part to inventory. Items cannot be changed from inventory to non-inventory. Make any changes carefully as these changes cannot be undone and could affect prior period balances.

The most important aspect of using inventory in QuickBooks is to always ensure an item is purchased before it is sold. The client should understand the significance of negative inventory quantities. Warning messages about negative inventory should never be ignored.

**Inventory Purchases versus Sales**

Perpetual inventory systems require adherence to proper procedures for accurate inventory control. Consistency in entering key transactions associated with the inventory items is key. An Item QuickReport is a quick way to confirm the item has only been sold when positive quantities on hand were showing.

<table>
<thead>
<tr>
<th>Item QuickReport</th>
<th>Inventory Item QuickReport</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rock Castle Construction</strong></td>
<td><strong>All Transactions</strong></td>
</tr>
<tr>
<td>Item</td>
<td>Date</td>
</tr>
<tr>
<td>Invoice</td>
<td>11/25/2014</td>
</tr>
<tr>
<td>Bill</td>
<td>10/21/2007</td>
</tr>
<tr>
<td>Item Receipt</td>
<td>10/29/2007</td>
</tr>
<tr>
<td>Bill</td>
<td>10/27/2007</td>
</tr>
<tr>
<td>Invoice</td>
<td>10/30/2007</td>
</tr>
<tr>
<td>Bill</td>
<td>11/12/2007</td>
</tr>
<tr>
<td>Invoice</td>
<td>12/12/2007</td>
</tr>
<tr>
<td>Bill</td>
<td>12/22/2007</td>
</tr>
<tr>
<td>Invoice</td>
<td>12/23/2014</td>
</tr>
<tr>
<td>Invoice</td>
<td>12/21/2007</td>
</tr>
<tr>
<td>Invoice</td>
<td>12/21/2007</td>
</tr>
<tr>
<td>Invoice</td>
<td>12/21/2007</td>
</tr>
<tr>
<td>Invoice</td>
<td>12/21/2014</td>
</tr>
<tr>
<td>Bill</td>
<td>12/21/2014</td>
</tr>
<tr>
<td>Total On Hand As Of 12/31/2014</td>
<td>122</td>
</tr>
</tbody>
</table>

**Purchases**

| Item | Date | Item | Item | Qty | Amount |
| Purchase Order | 12/21/2007 | Interior door | 0 | 560.00 |
| Purchase Order | 12/21/2014 | Interior door | 6 | 1,726.00 |
| Purchase Order | 12/21/2014 | Interior door | 11 | 2,811.11 |
| Total On Purchase Order As Of 12/31/2014 | 75 | 5,740.00 |

**Total:**

<table>
<thead>
<tr>
<th>Item</th>
<th>Qty (Units)</th>
<th>Cost (Amount)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wood Door</td>
<td>112</td>
<td>4,480.00</td>
</tr>
<tr>
<td>Total Inventory</td>
<td></td>
<td>7,094.17</td>
</tr>
<tr>
<td>TOTAL As Of 12/31/2014</td>
<td>197</td>
<td>7,094.17</td>
</tr>
</tbody>
</table>
Item Receipts

If an item has been received, but the bill has not arrived, an item receipt should be created. An item receipt will not age in Accounts Payable until the Item Receipt form is edited to indicate that the bill has been received. The item receipt will increase the Inventory and Accounts Payable balances. This Item Receipt can also be linked to a Purchase Order either when the vendor name is entered, or from the Select PO button at the bottom of the Items tab.

NOTE: When the bill is received, click on the box in the upper right hand corner and the terms and due date fields will appear. This will activate proper aging and permit bill payment procedures. This step is important, if a new bill is entered rather than the item receipt being edited, the Inventory and Accounts Payable balances will be inflated. You can also achieve these same steps by entering a bill for items already received from the home page. An error message helps warn when a bill is entered but an Item Receipt already exists.
Inventory Quantity or Value Adjustments

To review the details of inventory values, select the Reports menu > Inventory, choose Inventory Valuation Summary. This report provides information about the quantity on hand as well as the value it is assigned in Inventory.

QuickBooks uses average costing for the inventory value. The total asset value on this report should agree on the same date and time with the Balance Sheet value for Inventory. These numbers can differ if users create Journal Entries and post them directly to the Inventory account. The inventory adjustments function should always be used to adjust inventory values rather than through a Journal Entry.

Create the following report to identify transactions that have been posted to the Inventory account via Journal Entries. Chart of Accounts > Inventory, select the Reports tab at the bottom of the screen, and then select QuickReport. > Modify Reports, then All for the date range and filter the Transaction Type to Journal Entry.

<table>
<thead>
<tr>
<th>Item Description</th>
<th>On Hand</th>
<th>Avg Cost</th>
<th>Asset Value</th>
<th>% of Total Asset</th>
<th>Sales Price</th>
<th>Retail Value</th>
<th>% of Total Retail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cabinet Pulls</td>
<td>104</td>
<td>1.05</td>
<td>171.22</td>
<td>0.9%</td>
<td>0.00</td>
<td>6.00</td>
<td>0.0%</td>
</tr>
<tr>
<td>Light Pure</td>
<td>9</td>
<td>1,000.00</td>
<td>12,000.00</td>
<td>65.7%</td>
<td>1,789.20</td>
<td>14,320.00</td>
<td>56.6%</td>
</tr>
<tr>
<td>Cabinets - Other</td>
<td>3</td>
<td>6.00</td>
<td>0.00</td>
<td>0.0%</td>
<td>0.00</td>
<td>6.96</td>
<td>0.0%</td>
</tr>
<tr>
<td>Total Cabinets</td>
<td>119</td>
<td>13,711.22</td>
<td>46.4%</td>
<td>14,320.00</td>
<td>56.6%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item Description</th>
<th>On Hand</th>
<th>Avg Cost</th>
<th>Asset Value</th>
<th>% of Total Asset</th>
<th>Sales Price</th>
<th>Retail Value</th>
<th>% of Total Retail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boot Frame</td>
<td>2</td>
<td>12.06</td>
<td>24.00</td>
<td>0.1%</td>
<td>0.00</td>
<td>6.00</td>
<td>0.0%</td>
</tr>
<tr>
<td>Hardware</td>
<td>663</td>
<td>3.00</td>
<td>1,980.00</td>
<td>5.3%</td>
<td>0.00</td>
<td>6.00</td>
<td>0.0%</td>
</tr>
<tr>
<td>Bookcase Std</td>
<td>103</td>
<td>27.00</td>
<td>2,781.00</td>
<td>10.6%</td>
<td>30.00</td>
<td>3,250.00</td>
<td>12.1%</td>
</tr>
<tr>
<td>Lk Bookcase</td>
<td>111</td>
<td>38.56</td>
<td>3,416.11</td>
<td>14.9%</td>
<td>38.60</td>
<td>4,218.00</td>
<td>16.8%</td>
</tr>
<tr>
<td>Hardware - Other</td>
<td>3</td>
<td>6.00</td>
<td>0.00</td>
<td>0.0%</td>
<td>0.00</td>
<td>6.00</td>
<td>0.0%</td>
</tr>
<tr>
<td>Total Hardware</td>
<td>774</td>
<td>5,076.11</td>
<td>30.8%</td>
<td>7,270.00</td>
<td>26.7%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item Description</th>
<th>On Hand</th>
<th>Avg Cost</th>
<th>Asset Value</th>
<th>% of Total Asset</th>
<th>Sales Price</th>
<th>Retail Value</th>
<th>% of Total Retail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interior Book kit</td>
<td>4</td>
<td>123.17</td>
<td>493.50</td>
<td>1.9%</td>
<td>0.00</td>
<td>6.00</td>
<td>0.0%</td>
</tr>
<tr>
<td>Total Assembly</td>
<td>4</td>
<td>488.66</td>
<td>1.9%</td>
<td>6.00</td>
<td>0.0%</td>
<td>6.00</td>
<td>0.0%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>Date</th>
<th>Memo</th>
<th>Split</th>
<th>Amount</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory/Asset</td>
<td>10/8/2014</td>
<td>Cost of Good...</td>
<td></td>
<td>1,325.00</td>
<td>1,325.00</td>
</tr>
<tr>
<td>Total Inventory/Asset</td>
<td>1,325.00</td>
<td>1,325.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOTAL</td>
<td></td>
<td></td>
<td></td>
<td>1,325.00</td>
<td>1,325.00</td>
</tr>
</tbody>
</table>
The correct process is to make a change to Inventory for quantity changes or value changes from **Vendors > Inventory Activities > adjust Quantity/Value on Hand**.

The quantity by which you desire to change the amount is marked in the Quantity difference column. How the change will affect the inventory is shown in the lower left corner.
PRIOR PERIOD BALANCE DISCREPANCIES

ERRORS & SYMPTOMS

Common Error
- Users record, modify, delete and void transactions in accounting periods for which tax returns have already been prepared and filed

Symptom
- Ending balances used by the tax accountant have changed from year to year

Often, clients make changes in their QuickBooks file to prior periods and are not aware of the affect these changes have. When tax returns have been completed and filed, prior period adjustments must be handled carefully and cautiously.

QuickBooks provides tools for not only preventing changes to prior periods, but also finding them easily. The Troubleshoot Account Balances tool in the Client Data Review identifies these transactions quickly.
TROUBLESHOOT ACCOUNT BALANCES

The first year the Client Data Review is used, will require the Ending Trial Balance from the prior period’s tax return or financial statement be entered. When the Client Data Review is started in future periods, the prior information is populated in the Last Review Balances column as long as the review takes place in the client’s file. After entering the Trial Balance from the previous period, the Difference column calculates the entry that needs to be made to adjust the account balances back to the last reviewed balance. The transactions that contributed to the balance discrepancy can be reviewed by double clicking on the difference in blue and using QuickZoom to open into the discrepancy. Alternatively, the View Changed Transactions at the top of the window can be used to generate a report of the transactions that contributed to the discrepancy. Once the differences have been reviewed and the adjustment proposed to adjust the prior ending balances to the prior trial balance, then select View Suggested Adjustments.
Most Common QuickBooks Mistakes and How to Fix Them

After selecting **View Suggested Adjustments**, the **Make Journal Entries** window opens. The **Adjusting Entry** box is checked with the journal entry date being the ending date of the prior period. Note that in this example, part of the adjustment is to Accounts Receivable. Therefore, a customer must be entered in the line of the journal entry similar to “CPA adj”. Once the adjustment is entered correctly, select **Save & Close**.

![Make General Journal Entries](image)

Once the Adjusting Journal Entry is saved, the following message appears:

![Reversing Entries](image)

Choose **View Suggested Reversing Entries** if any part of the entry should be reversed on 1/1 of the following year. If there are certain accounts to remove or add to the reversing journal entry, these can be added once the journal entry appears. Then choose **Save & Close** on the reversing entry. If you prefer not to reverse the entry at 1/1, then choose **Don't Reverse**.

As each task is completed, the status can be changed from **Not Started** to **In Progress** or **Completed** within CDR.
ADDITIONAL REPORTING TO HELP TROUBLESHOOT BEGINNING BALANCE CHANGES IN QUICKBOOKS

QuickBooks provides several reports to assist in troubleshooting beginning balances when the problem cannot be identified through the Client Data Review tool. Each of these reports can be found by selecting Reports, Accountant & Taxes and choosing a report that will best troubleshoot the problem in the beginning balance discrepancy.

Audit Trail Report

The Audit Trail Report lists all transactions entered and the complete history of changes, deletions and/or voids to those transactions. If a client makes a change to a prior period transaction, the Audit Trail Report will show the changes.

<table>
<thead>
<tr>
<th>Date</th>
<th>Name</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/05/2011</td>
<td>ABC Contractor</td>
<td>Accounts Payable</td>
<td>999.00</td>
<td></td>
</tr>
<tr>
<td>04/05/2011</td>
<td>ABC Contractor</td>
<td>Job Expenses:Job...</td>
<td></td>
<td>999.00</td>
</tr>
</tbody>
</table>

- Bill

<table>
<thead>
<tr>
<th>Date</th>
<th>Name</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>05/01/2009</td>
<td>ABC Contractor</td>
<td>Accounts Payable</td>
<td>888.00</td>
<td></td>
</tr>
<tr>
<td>05/01/2009</td>
<td>ABC Contractor</td>
<td>Job Expenses:Job...</td>
<td></td>
<td>888.00</td>
</tr>
</tbody>
</table>

- Bill

<table>
<thead>
<tr>
<th>Date</th>
<th>Name</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>05/01/2009</td>
<td>ABC Contractor</td>
<td>Accounts Payable</td>
<td>666.00</td>
<td></td>
</tr>
<tr>
<td>05/01/2009</td>
<td>ABC Contractor</td>
<td>Job Expenses:Job...</td>
<td></td>
<td>666.00</td>
</tr>
</tbody>
</table>
The Audit Trail Report can be filtered based on a number of different criteria. To filter this report, select Export from the report window and select the Advanced tab of the Export Report window. Then check the box labeled Auto Filtering as shown below. With Auto Filtering turned on, each column can be filtered to only show transactions that match the criteria chosen.

![Export Report Window]

NOTE: The Audit Trail will only show “who” did what, provided that your client has set up a unique User ID for each person entering transactions into QuickBooks. If every person is sharing the same User ID (which is not recommended!) the Audit Trail will simply show a list of the transactions and changes to the file, but not “who” made the entries.
Closing Date Exceptions Report

The Closing Date Exceptions Report shows modifications or transactions entered dated on or before the Closing Date. Similar to the Audit Trail Report, the current status of the transaction as well as the original transaction are shown. The transactions that might need to be reversed, or adjusted, to get back to the correct balances are shown.

NOTE: This report will only show data if a Closing Date has been established, and if entries or changes are then made to those closed periods. Also —only changes made after the Closing Date has been established are tracked. If changes are made to an open period, and then a Closing Date applied, the changes made before establishing the Closing Date are not tracked. For this reason, it is best practice to close periods regularly and set a password for each period. However, the Audit Trail will record all transactions regardless of closed or open status for each period.

---

**Rock Castle Construction**

**Closing Date Exception Report**

Books Closed As of December 31, 2012

---

<table>
<thead>
<tr>
<th>Item</th>
<th>Entered</th>
<th>Last Modified</th>
<th>Last modified by</th>
<th>Date</th>
<th>Name</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Closing Date History**

- Closing date set to 12/31/2012 on 04/05/2011 11:21:23 by Admin
- Closing date set to 12/31/2012 on 05/25/2012 13:45:49 by Admin
- Closing date set to 09/30/2012 on 05/25/2012 13:45:49 by Admin
- Closing date set to 09/30/2012 on 12/25/2012 13:45:49 by Admin

**Transactions entered or modified by Admin**

**Invoice 74**

<table>
<thead>
<tr>
<th>Item</th>
<th>Entered</th>
<th>Last Modified</th>
<th>Last modified by</th>
<th>Date</th>
<th>Name</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>74</td>
<td>04/05/2011 06:04:57</td>
<td>Admin</td>
<td>Deleted</td>
<td>0.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>74</td>
<td>06/25/2012 14:54:25</td>
<td>Unknown</td>
<td>Prior 12/15/2012</td>
<td>Baker, Chris Family... Accounts Receivable</td>
<td>1,040.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Baker, Chris Family... Construction Labor</td>
<td>365.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Baker, Chris Family... Construction MISC</td>
<td>525.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Baker, Chris Family... Construction Labor</td>
<td>165.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>State Board of Equal... Sales Tax Payable</td>
<td>0.00</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Transactions entered or modified by Unknown user**

**Invoice 74**

<table>
<thead>
<tr>
<th>Item</th>
<th>Entered</th>
<th>Last Modified</th>
<th>Last modified by</th>
<th>Date</th>
<th>Name</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>04/05/2011 06:04:57</td>
<td>Admin</td>
<td>Deleted</td>
<td>0.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>74</td>
<td>06/25/2012 14:54:25</td>
<td>Unknown</td>
<td>Prior 12/15/2012</td>
<td>Baker, Chris Family... Accounts Receivable</td>
<td>1,040.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Baker, Chris Family... Construction Labor</td>
<td>365.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Baker, Chris Family... Construction MISC</td>
<td>525.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Baker, Chris Family... Construction Labor</td>
<td>165.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>State Board of Equal... Sales Tax Payable</td>
<td>0.00</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Voided/Deleted Transactions Report

QuickBooks creates an activity log of all voided and deleted transactions. This report is not dependent on the Closing Date because QuickBooks tracks the activity whether or not the transaction is dated in a previous reporting period.

## Voided/Deleted Transactions Summary

<table>
<thead>
<tr>
<th>Num</th>
<th>Action</th>
<th>Entered/Last Modified</th>
<th>Date</th>
<th>Name</th>
<th>Memo</th>
<th>Account</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Deleted Transaction</td>
<td>04/05/2011 09:45:31</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>74</td>
<td>Changed Transaction</td>
<td>04/05/2011 09:44:02</td>
<td>05/01/2014</td>
<td>ABC Contractor</td>
<td></td>
<td>Accounts Pay</td>
</tr>
<tr>
<td></td>
<td>Added Transaction</td>
<td>05/04/2008 18:03:19</td>
<td>05/01/2009</td>
<td>ABC Contractor</td>
<td></td>
<td>Accounts Pay</td>
</tr>
</tbody>
</table>

### Invoice 74

<table>
<thead>
<tr>
<th>Num</th>
<th>Action</th>
<th>Entered/Last Modified</th>
<th>Date</th>
<th>Name</th>
<th>Memo</th>
<th>Account</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Deleted Transaction</td>
<td>04/05/2011 09:04:37</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Payment

<table>
<thead>
<tr>
<th>Num</th>
<th>Action</th>
<th>Entered/Last Modified</th>
<th>Date</th>
<th>Name</th>
<th>Memo</th>
<th>Account</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Deleted Transaction</td>
<td>04/05/2011 09:04:50</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Changed Transaction</td>
<td>04/05/2011 09:09:45</td>
<td>05/04/2014</td>
<td>Baker, Chris</td>
<td>Baker, Chris Family...</td>
<td>Undeposited Funds</td>
</tr>
<tr>
<td></td>
<td>Added Transaction</td>
<td>05/04/2009 17:33:36</td>
<td>05/04/2009</td>
<td>Baker, Chris</td>
<td>Baker, Chris Family...</td>
<td>Undeposited Funds</td>
</tr>
</tbody>
</table>

### Transactions entered or modified by Unknown user

<table>
<thead>
<tr>
<th>Num</th>
<th>Action</th>
<th>Entered/Last Modified</th>
<th>Date</th>
<th>Name</th>
<th>Memo</th>
<th>Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>74</td>
<td>Deleted Transaction</td>
<td>04/05/2011 09:04:37</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To display more information about a transaction on this report, double-click on the transaction. QuickBooks will then display the impact of the original transaction on the General Ledger.
**Retained Earnings Quick Report**

In QuickBooks versions since 2005 the detail of transactions posted to Retained Earnings can be viewed. Select the Lists menu > Chart of Accounts and then double click on Retained Earnings account.

<table>
<thead>
<tr>
<th>Type</th>
<th>Date</th>
<th>Memo</th>
<th>Debit</th>
<th>Credit</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closing Entry</td>
<td>1/20/2010</td>
<td></td>
<td>-145,539.68</td>
<td></td>
<td>-137,199.11</td>
</tr>
<tr>
<td>Closing Entry</td>
<td>12/31/2010</td>
<td></td>
<td>-145,539.68</td>
<td></td>
<td>-137,199.11</td>
</tr>
<tr>
<td>Closing Entry</td>
<td>12/31/2011</td>
<td></td>
<td>-145,539.68</td>
<td></td>
<td>-137,199.11</td>
</tr>
<tr>
<td>General Journal</td>
<td>12/31/2011</td>
<td>Troubleshoot Balances... Checking</td>
<td>1,318.76</td>
<td>-146,059.44</td>
<td></td>
</tr>
<tr>
<td>Closing Entry</td>
<td>12/31/2011</td>
<td></td>
<td>1,318.76</td>
<td>-146,059.44</td>
<td></td>
</tr>
<tr>
<td>6/19/2014</td>
<td>Accounts Payable</td>
<td>850.00</td>
<td></td>
<td>-137,199.11</td>
<td></td>
</tr>
</tbody>
</table>

Identify entries made in error to the Retained Earnings Account. Double click on an entry to edit and correct the account assigned.
**Working Trial Balance**

Entries can be made through the Working Trial Balance in the Client Data Review Tool as journal entries, you can then enter all of your adjustments through this screen. You will be able to:

- See your client's net income at a glance after each adjusting entry
- Review transactions in your client's accounts, including the Retained Earnings account.
- Enter adjusting journal entries
- Enter *Workpaper References* for account adjustments

![Working Trial Balance](image-url)
Edit transactions or make adjusting journal entries from this window. Select Make Adjustments to open the Make General Journal Entries window.

QuickBooks defaults this entry as an Adjusting Entry so the entry will appear in the Adjustments column on the Working Trial Balance window. Selecting a time period in the Make General Journal Entries screen will show a list of all journal entries and indicate if the entry is an adjusting entry.
**SET CLOSING DATE AND PASSWORD**

Setting a closing date and password so that changes are saved and cannot be undone without the user knowing the password is strongly recommended. Even if the client knows the password and makes changes after the data file is given back, the Closing Date Exception Report records any changes the client makes, as long as the closing date password is set. When selecting this line item, the following window appears:

![Set Closing Date and Password Window](image)

Select **Set Date/Password** in the Accounting section on the Company Preferences tab, then enter the **Closing Date** and **Closing Date Password** where prompted.

![Set Date/Password Window](image)
Some tips to remind clients of the severity of making changes to a closed period are:

- Make the password your name
- Make the password your phone number
- Make the password a dollar amount such as $500 to represent the cost to the client to fix or file an amended tax return if unnecessary changes are made to the prior year.
OPENING BALANCE EQUITY ACCOUNT

ERRORS & SYMPTOMS

Common Errors

- Users do not know what to do with the Open Balance Equity account
- Users enter an opening balance when setting up a new account, vendor, customer or inventory item
- Users create transactions that post to the Open Balance Equity account

Symptoms

- Balance remains in Open Balance Equity account long after initial start up of the data file
- Open Balance Equity account has a balance

WHY TRANSACTIONS POST TO THE OPEN BALANCE EQUITY ACCOUNT

QuickBooks automatically records the following transactions to the Opening Balance Equity account:

- The ending bank statement balance transaction when a new bank account is created in the EasyStep Interview
- Opening balances for other Balance Sheet accounts created in the Add New Account dialog box
- Opening balances entered when New Customers or Vendors are setup
- Inventory total value balances entered in the New Item dialog
- Bank reconciliation adjustments for QuickBooks versions 2005 or earlier

Other common transactions that a user might assign to this account include:

- Accrual basis opening accounts payable transactions as of the start date
- Accrual basis opening accounts receivable transactions as of the start date
- Uncleared bank checks or deposits (accrual or cash basis) as of the start date
**Reviewing Balances in Open Balance Equity Account**

To review the transactions in Opening Balance Equity account a report of the transactions is first created.

To create a report of the transactions in the Opening Balance Equity account:

2. Without adjusting the date, view the Equity section of the report to see whether a balance exists in the account.

The Opening Balance Equity account value might be equal to the prior year Retained Earnings. So, if a balance in the Opening Balance Equity account exists and if the balance is equal to the prior year’s Retained Earnings, the Opening Balance Equity can be closed into Retained Earnings—as discussed in the next section.

If, however, a balance remains on the Balance Sheet for Opening Balance Equity, you can review the individual transactions by creating the following report:

1. Click **Reports > Custom Transaction Detail Report**. The Modify Report dialog appears, with the Display tab selected.
2. Select the **Report > Date Range** to be reviewed. Choose **All** from the Dates drop-down menu.
3. In the Columns section of the Display tab, click to place a check mark next to those data fields to be included on the report, or click to remove the check mark from those not to be included on the report. Be sure to include **Type** near the top of the list.
4. Click the **Filters** tab.
5. In the **Choose Filter** pane, select **Account**; from the **Account** drop-down menu select the **Opening Balance Equity** account, as shown in the image below.
6. Optionally, for the **Sort By** drop-down list, select **Type**. This option groups the report by type of transaction, which might make reviewing the source of the transactions easier.
With the report sorted by type of transaction, determine whether errors in entries were made is the next step.

One of the most important things to know about the Opening Balance Equity account is that when a file is completely and successfully set up, no balances should remain in the Opening Balance Equity account.
**Closing Opening Balance Equity to Retained Earnings**

The Opening Balance Equity account should have a zero balance once a file is set up correctly. A correctly set up QuickBooks file assumes the following:

- You are not converting the data from Quicken, Peachtree, Microsoft Small Business Accounting or Office Accounting. Each of these products has an automated conversion tool available free from Intuit that eliminates the need to make startup transactions if the data is converted and not just lists.

- The company had transactions prior to the QuickBooks start date (i.e., it is not a new business). If it is a new business with no prior transactions, then simply begin entering typical QuickBooks transactions with no need for unusual start up entries.

- If there were transactions prior to the QuickBooks start date, and each of the unpaid customer invoices, unpaid vendor bills, and uncleared bank transactions have been entered and dated prior to the QuickBooks start date.

- The trial balance has been entered one day before the QuickBooks start date. (i.e. if the fiscal year starts 1/1 then the trial balance is dated 12/31 of the previous year).

If the above stipulations are true, then the Opening Balance Equity is expected to equal the Retained Earnings balance from the accountant’s financials or from the prior software.

If it does not agree, continue to review the data to identify the errors.

If it does agree, then make the final entry in the startup process to close out the balance in Opening Balance Equity to Retained Earnings.
VOID A CHECK WRITTEN IN A PRIOR PERIOD

Clients often need to void checks that were written in a prior period. However, prior period income and expenses should not be changed for various reasons such as tax returns having been prepared. The usual option is Void Check under the Edit menu.

However, this takes the original transaction and changes the amount to $0. The date of the transaction is the date the change of the dollar amount of the transaction will be effective. To prevent a change to the prior year accounting data, the voiding of a prior period check in the current period requires the entry of a deposit for the check that is to be voided.
During the bank reconciliation process, the check to be voided and the deposit are both cleared. The memo field on both the check and the deposit should reference the voided check. This will successfully void the check in the subsequent period. Differing From Accounts may want to be used on the Deposit depending on the reason for the voided check.
**WORKING WITH CLASSES**

Clients that use class tracking can print reports that provide income and expenses by class. Classes frequently represent divisions within a company. A Profit and Loss Report can show the income and expenses per class. Selecting the **Profit & Loss by Class** report from the **Report Center** will generate a report that shows the income and expenses that have been assigned to a class. For QuickBooks versions 2010 and earlier, the report does not, however, report the transactions to which a class has not yet been assigned. See the following report example.

<table>
<thead>
<tr>
<th>Rock Castle Construction</th>
<th>Profit &amp; Loss by Class</th>
<th>January through December 2014</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ordinary Income/Expense</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Income</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design Income</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Construction</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Labor</td>
<td>5,755.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Materials</td>
<td>0.00</td>
<td>41,418.41</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>0.00</td>
<td>2,000.00</td>
</tr>
<tr>
<td>Subcontractors</td>
<td>0.00</td>
<td>6,065.76</td>
</tr>
<tr>
<td><strong>Total Construction</strong></td>
<td>5,755.00</td>
<td>2,000.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To identify the transactions that have not been assigned to a class, a Profit and Loss report is generated and the column option at the top of the window is set to Class. This will produce the report as follows.

The Client Data Review can be used to reclassify transactions to add or change classes. If CDR is not available, QuickZoom on any Total row of the Unclassified column for the detail of the transactions that have not been assigned to a class.
WORKING WITH JOBS

Clients that use job costing run job costs reports with the expectation that the reports include all job costs. QuickBooks does not contain predetermined reports to identify transactions that have not been assigned to a job. A Profit and Loss by Job will contain all jobs with activity during the period specified in columns across the report; however, those costs not assigned to jobs will not be contained in the report.

To determine costs not assigned to a job, select the Profit and Loss Report for the period under review. Use the column option of the top of the report to select Job. This report will be exactly the same as the Profit and Loss by Job report already defined in the Report Center, with one important difference, a column entitled No Name In which are all of the costs not associated with a job will appear. QuickZoom on any row in the column to see the detail of the costs that have not been assigned to a job.
WORKING WITH PAYPAL ACCOUNTS

More and more clients are using PayPal for business transactions. To record these, create a new account and select the account type of Bank as shown in the image below. Now, users can record purchases paid for with the PayPal account as well as deposits into the PayPal account as with any other bank account in QuickBooks.

When users record a deposit to the PayPal account, add another line to record the PayPal fees so the net deposit matches the PayPal amount. Users should also reconcile the QuickBooks PayPal account to PayPal reports.
**Downloading and Importing PayPal Transactions**

Another option is to download transactions from PayPal and import them into QuickBooks.

- As always, create a back up of the data file *before* downloading and importing transactions
- Only import each download once to avoid duplicate entries
- If you want to test/try it in a sample file do this:
  - Create a backup of your QuickBooks file
  - Restore the backup giving it a name of practice (when it is saving the file)

In the newly restored file, go to **Company > Company Information**, and change the name to ‘practice’ (so on the blue title bar the practice file title will be displayed).

To download PayPal account activity:

1. Log into your PayPal account.
2. Go to the **My Account** tab.
3. Right above the transactions, click on the all account activity link.
4. On the left side, in the **History** box, click on **Download My History** link.
5. Select the dates of transactions that you want to download (after your first download, it is a good idea to select **Last Download to Present** so you do not duplicate transactions).
6. Select the **File** type to download—QuickBooks (iif).
7. QuickBooks asks what accounts to use for the PayPal account, expense account (for the fees and any payments that were made), and income account (Donations—Online).

8. Save the file to an appropriate folder on a hard drive—possibly name it with the date.

9. In QuickBooks, go to File > Utilities > Import > iif, and select the file just saved.

10. Included in the download automatically is the PayPal fees deducted from the deposits.

11. The Payee’s name will be put on the other names list. They can be moved them to the customer list by:

   a. Go to Lists > Other Names list, and double click on the appropriate name.
   b. On the right (under OK, Cancel, etc.) you’ll see a box for Change Type.
   c. Change the type to Customer.

12. When funds are transferred from PayPal into the bank account, enter the transfer into QuickBooks. Go to Banking > Transfer > From the PayPal account, to the checking account for the appropriate amount.
**JOURNAL ENTRIES OVERVIEW**

In traditional accounting, the journal entry is a record of a transaction in which the total amount in the Debit column equals the total amount in the Credit column, and each amount is assigned to an account on the chart of accounts. For the day-to-day transaction entry, QuickBooks uses familiar forms (invoices, bills, checks, etc.) and the back-end journal entries are created automatically. When a transaction is entered directly into a non-bank balance sheet account register, QuickBooks automatically labels the transaction `GENJRNL` in the register and General Journal on reports that list transactions.

In traditional accounting systems, various closing procedures must be performed. QuickBooks automates this process by automatically transferring net income into the Retained Earning account at the beginning of a new fiscal year when Balance Sheet reports are generated. A journal entry is not created for this process, the net transaction amount just appears in the Retained Earnings account.

The net profit or loss each year should be “closed” into an account other than Retained Earnings. One is to change the name of the account (i.e., for a sole proprietorship change the name of Retained Earnings to Owner’s Equity). The second alternative is to create a journal entry to reclassify the amount correctly (i.e., reclassify retained earnings to various partner accounts). To protect the integrity of the data for the future, use the password protection feature of closing dates.

A manual journal entry can be made from the Company pull down menu. In traditional accounting systems, to “post” is to transfer data from the book of original entry to a ledger. In QuickBooks, the original entry is on a form (invoice, bill, check, and so on), and the equivalent of a ledger is a report. QuickBooks handles all posting automatically and immediately when forms are recorded.

QuickBooks also allows you to correct mistakes by editing and recording the original form again at any time. To protect previous records from accidental change, use a QuickBooks password and closing date.

Entries for depreciation, tax provisions, etc. must be made in the more traditional fashion. For clients using job costing reports, there are several places which do not permit a customer to be assigned to the amounts, so a journal entry is required to reclassify the amount within the same account from no name (i.e., blank) customer to the correct customer: job.

With many traditional software packages, any adjustments are handled through journal entries in the general ledger. In QuickBooks, however, the creation of journal entries, and their impact on the financial statements, may not achieve the desired results, and are better handled through the use of the appropriate form or transaction entry page.

Each transaction is recorded in the general ledger via journal entries. A report can be prepared that presents the details for each transaction. This report, by default, includes the feature of collapsing the detail lines for the same account into one line. This is indicated by the notation of multiple in the memo column. To see the individual detail lines, click on the Expand button at the top of the report. This report can also be filtered for a specific transaction type (for example, journal), by date entered/modified, by a specific memo, etc.
Journal Entries

Typical journal entries for QuickBooks include booking depreciation entries, income tax provisions, and loan interest adjustments. If a journal entry is in fact needed, consider the following rules:

- Only one Accounts Receivable or Accounts Payable type account per entry
- On the journal entry itself, use the Accounts Receivable or Accounts Payable account on the second line of the journal entry so that it properly posts
- Any entry to an Accounts Receivable or Accounts Payable type account will require a customer or vendor, respectively
- If QuickBooks is used as a write up program and Accounts Receivable or Accounts Payable detail is provided from another system, it is usually more efficient to create the accounts using the Other Current Asset or Other Current Liability type accounts
- All journal entries may be considered to be cash basis, regardless of the accounts affected based on where the Accounts Receivable and Accounts Payable accounts are placed in the journal entry
- Journal entries should not be made to inventory or payroll accounts. To do so may create subsidiary reports that do not agree with the general ledger.
- Entries can be made to correct class entries by choosing the same account for the debit and credit and only making the class designation different. This will re-allocate between classes, while leaving the General Ledger account the same.
- As each journal entry is saved, the General Ledger is automatically updated
- To create a report of just the journal entries, filter the Transaction Detail by Account report or the Audit Trail report for the transaction type of journal. If only the accountant journal entries are to be printed, choose the entered/modified date from the point that the financial statement reconciliation work began to the current date.

Recording Expenses Paid for by the Owner

Frequently business owners will pay for business expenses with personal funds. These expenses can be recorded in one of several ways. How quickly the business will repay the expenses can determine the best way for the client to record the transactions.

- If the client is paying the expenses immediately, users can write a check to reimburse the owner for the business expenditures paid for with personal funds
- If the owner cannot reimburse themselves in the short term, a journal entry can record the expenditures. While the expenses paid will be debited, the account to be credited can vary depending on the legal structure of the business. The account to be credited can be a Loan from Shareholder account if loan documents have been drafted or Owners Contribution, an equity account, if the expenses are considered capital contributions. Clients should consult their tax professional if they are unsure of the proper account.
- In some cases, the owner may wish to be reimbursed, but the business is unable to pay the expenses in full. A credit card type account could be created to account for the transactions as discussed in the section on Credit Cards and the name of the account could be Due to Owner-Short Term or similar description.
USING MULTIPLE CURRENCIES

A client may inquire about the use of multiple currencies. There are a few things they should know prior to enabling the QuickBooks Multi Currency Functionality. First, the option to turn on multiple currencies is not reversible. A client should make a backup copy of the file prior to turning on the multi currency indicators in case they desire to revert back to a single currency.

Second, once the multiple currency preference is turned on, then other currencies to track must be selected. Use the Lists, Currency List to select the other currencies you wish to track.
As transactions are added that occurred in other currencies, the accounts and vendors are linked to their different currencies and the transactions are entered in the other currency. An exchange rate must be used for transactions. The amount shown on this transaction will be reported in the financial statements in US dollars at the amount indicated, via the amount of foreign currency entered and the exchange rate used. In the example below, the transaction is entered at 185 Euros, via the exchange rate, the transaction will be reported in the financial statements at $137.83 (US Dollars).
**USING UNIT OF MEASURE**
A client involved with buying and selling of inventory, may utilize the Unit of Measure functionality. Unit of Measure is enabled from the **Items and Inventory** section of **Preferences** under the **Company Preferences** tab.

Once the Unit of Measure has been enabled, then the U/M Set list must be defined.

The key to the success of using the Unit of Measure feature is to make sure the lowest level of measurement is used as the base and built up from there.
For example, if the client sells a liquid by the fluid ounce, but purchases the liquid by the gallon, then the ounce will be the smallest unit of measure, with gallons being how the goods will be purchased from vendors.

The **Volume** unit will be selected. Once the **Unit of Measure** is set up, then each inventory item must contain the designated units of measure.
Once the inventory item is created, when the item is purchased, the purchase order now has a column for the U/M. Individual Units of Measure can be created if items are purchased in bulk and sold in smaller quantities, or vice versa.

Symptoms of problems with use of the Unit of Measure functionality are in the inventory quantities. If an Inventory Stock Status report is produced, the Unit of Measure is shown. This Unit of Measure must correspond to the quantities on hand.
CREATE A PRACTICE/TESTING FILE

A client may sometimes need a way of testing transactions or allowing users to practice making entries. A test or practice file can be created. Using a copy of the Client’s data file at a point in time will allow them to use Customers, Vendors and items they are familiar with. To create a practice file from an actual data file:

- Create a backup of the client’s QuickBooks file
- Restore the backup, saving the file with a clearly unique name in the title so to leave no doubt as to the working file and the practice file (Practice, Sample, Testing)
- Open the newly restored practice file, go to Company > Company Information, and change the name to “Practice File,” “Sandbox,” or some other name to clearly denote that this file is not the working file for the business. The color of the background or desktop can also be changed to clearly differentiate the practice file. Go to Edit > Preferences > Desktop > My Preferences, and change the color scheme. Clients can toggle between the practice and real file via File > Open Previous Company.